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Alibaba Cloud reminds you to carefully read and fully understand the terms and

conditions of this legal disclaimer before you read or use this document. If you have
read or used this document, it shall be deemed as your total acceptance of this legal
disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website
or other Alibaba Cloud-authorized channels, and use this document for your

own legal business activities only. The content of this document is considered
conﬁdential information of Alibaba Cloud. You shall strictly abide by the

conﬁdentiality obligations. No part of this document shall be disclosed or provided
to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted,

or disseminated by any organization, company, or individual in any form or by any
means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify

the content of this document without notice and the updated versions of this
document will be occasionally released through Alibaba Cloud-authorized

channels. You shall pay attention to the version changes of this document as they

occur and download and obtain the most up-to-date version of this document from
Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud

products and services. Alibaba Cloud provides the document in the context that
Alibaba Cloud products and services are provided on an "as is", "with all faults

" and "as available" basis. Alibaba Cloud makes every eﬀort to provide relevant
operational guidance based on existing technologies. However, Alibaba Cloud

hereby makes a clear statement that it in no way guarantees the accuracy, integrity
, applicability, and reliability of the content of this document, either explicitly

or implicitly. Alibaba Cloud shall not bear any liability for any errors or ﬁnancial
losses incurred by any organizations, companies, or individuals arising from

their download, use, or trust in this document. Alibaba Cloud shall not, under any
circumstances, bear responsibility for any indirect, consequential, exemplary,

incidental, special, or punitive damages, including lost proﬁts arising from the use
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or trust in this document, even if Alibaba Cloud has been notiﬁed of the possibility
of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to

works, products, images, archives, information, materials, website architecture,

website graphic layout, and webpage design, are intellectual property of Alibaba
Cloud and/or its aﬃliates. This intellectual property includes, but is not limited
to, trademark rights, patent rights, copyrights, and trade secrets. No part of the
Alibaba Cloud website, product programs, or content shall be used, modiﬁed

, reproduced, publicly transmitted, changed, disseminated, distributed, or

published without the prior written consent of Alibaba Cloud and/or its aﬃliates

. The names owned by Alibaba Cloud shall not be used, published, or reproduced

for marketing, advertising, promotion, or other purposes without the prior written
consent of Alibaba Cloud. The names owned by Alibaba Cloud include, but are

not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba

Cloud and/or its aﬃliates, which appear separately or in combination, as well as
the auxiliary signs and patterns of the preceding brands, or anything similar to

the company names, trade names, trademarks, product or service names, domain
names, patterns, logos, marks, signs, or special descriptions that third parties

identify as Alibaba Cloud and/or its aﬃliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions
Table -1: Style conventions
Style

Description

This warning information
indicates a situation that will

cause major system changes,
faults, physical injuries, and other
adverse results.
This warning information
indicates a situation that may

cause major system changes,
faults, physical injuries, and other
adverse results.
This indicates warning informatio
n, supplementary instructions,
and other content that the user
must understand.

This indicates supplemental
instructions, best practices, tips,
and other content that is good to
know for the user.

>

Multi-level menu cascade.

Bold

It is used for buttons, menus
, page names, and other UI
elements.

Courier It is used for commands.
font

Italics
[] or [a|b]

It is used for parameters and
variables.

It indicates that it is a optional
value, and only one item can be

Example
Danger:

Resetting will result in the loss of
user conﬁguration data.
Warning:

Restarting will cause business
interruption. About 10 minutes are
required to restore business.
Notice:

Take the necessary precautions
to save exported data containing
sensitive information.
Note:

You can use Ctrl + A to select all
ﬁles.

Settings > Network > Set network
type
Click OK.

Run the cd

/ d

C :/ windows

command to enter the Windows
system folder.
bae

log

list

--

instanceid Instance_ID
ipconfig [-all|-t]

selected.
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{} or {a|b} It indicates that it is a required
value, and only one item can be
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Example
swich {stand | slave}

selected.
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1 Deploy a WordPress site based on ECS and RDS

Alibaba Cloud Resource Orchestration Service (ROS) allows you to use templates to

create a group of Alibaba Cloud resources. The ROS template is a JSON text ﬁle used
to specify the resources that you want to create. This topic describes how to use a

template in ROS to deploy a WordPress site based on Elastic Compute Service (ECS)
and Relational Database Service (RDS).

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Procedure

1. Log on to the ROS console.
Note:

The ﬁrst time that you use the ROS service, you are prompted to activate this
service. ROS is a free service, so you can activate ROS free of charge.

2. In the left-side navigation pane, choose Key Help > ECS Instance Information, click
the ECS Instance Type tab to ﬁnd the target instance type in the Instance Type

column, click the ECS Zone tab to ﬁnd the target zone ID in the ZoneId column, and
then click the ECS Image tab to ﬁnd the target image ID in the Image List column.

3. In the left-side navigation pane, click Sample Template to display common
templates that ROS provides.

4. Find the sample template wordpress_instance.
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5. Click Preview to check the template in JSON format.

The following table lists the top-level ﬁelds in the JSON ﬁle.
Top-level ﬁeld

Description

" ROSTemplat
eFormatVer

sion " :

Speciﬁes the version of the template.

" 2015 - 09 - 01 "
" Parameters " : { }
" Resources " : { }

Speciﬁes some parameters. In this example, this ﬁeld
speciﬁes the default image ID and instance type.
Speciﬁes the resources that you can use the template
to create. In this example, this ﬁeld speciﬁes that the

resources to be created include an ECS instance and a
security group. The properties of these resources are
deﬁned in the Parameters ﬁeld.
" Outputs ": { }

6. Click Create Stack.

Speciﬁes the resource information that the stack
outputs after ROS creates the speciﬁed resources. In
this example, the stack outputs the ECS instance ID,
public IP address, and security group ID.

7. Select the region where the ECS instance is located from the Region drop-down list,
and click Next. In this example, China (Beijing) is speciﬁed.

8. Set stack parameters.

The following table lists the stack parameters.
Parameter name

Description

Creation timeout

Speciﬁes a period. If ROS fails to create the speciﬁed
resources within the period, the creation operation

Stack Name

Speciﬁes a unique stack name. You cannot change the
stack name after ROS creates the stack.
will time out. You can select or clear Roll back.

• If you select Roll back, ROS will delete the created
resources when an error such as creation timeout
occurs during the creation process.

• If you clear Roll back, ROS will not delete the
created resources when any error such as creation
timeout occurs during the creation process.

2
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Parameter name

Description

ECS Instance Type

The type of the ECS instance that you want to create.
For more information, see Step 2.

ECS Image Id

ECS Instance Password
and (Please Conﬁrm) ECS
Instance Password

The ID of the image that ROS uses to create the ECS
instance. For more information, see Step 2.

Specify the password for logon to the ECS instance
and conﬁrm the password. The password must be 8
to 30 characters in length and must contain at least
three of these character categories: letters, digits,
and special characters. Special characters include
parenthese s (( )), grave
accents
(`),

tildes

(!),
(#),

(~),

at

signs

dollar

(%),

exclamatio
(@),

signs

carets

(^),

($),

hyphens

s

plus

signs

vertical

brackets
(;),
(<>),

([]),

apostrophe
commas

marks

(?),

bars

(,),
and

percent
(-),

(+),
(|),

colons
s

signs

ampersands

(*),

(=),

points

number

asterisks
( _ ),

n

('),

(&),
underscore

equal
braces

(:),

forward

signs
({}),

semicolons

angle

periods

signs

(.),

brackets
question

slashes

(/).

Note:

The VPC Cidrblock
The VSwitch 2 Cidrblock

DB Instance Class

DB Instance Storage
ECS Zone Id

Passwords for Windows-based instances cannot
start with a forward slash (/).

The private CIDR block of a Virtual Private Cloud
(VPC). For more information, see #unique_4.

The CIDR block of a VSwitch. The CIDR block of the
VSwitch must fall within the CIDR block of the VPC

and cannot overlap with the CIDR block of an existing
VSwitch. For more information, see #unique_4.
The type of the ApsaraDB for RDS instance.

The storage capacity of the ApsaraDB for RDS
instance.

The zone ID of the resource that you want to create.
For more information, see Step 2.

Database Instance Engine The engine of the database that you want to use.
Type
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DB Name

The name of the MySQL database.

Database Engine Version

DB Username
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The version of the database engine that you want to
use.
The username of the MySQL database.
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Description

The password for accessing the MySQL database. The
password must be 8 to 32 characters in length.

The following ﬁgure shows the conﬁgured parameters.

9. Click Create.
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10.In the left-side navigation pane, click Stack Management, select the speciﬁed
region in the top navigation bar, and then ﬁnd the created stack.

11.Click the stack name, and in the left-side navigation pane, click the following tabs
to check the information about the stack:

• Overview: displays basic information, startup parameters, status, output, and
stack parameters.

• Resource: displays all resources of the stack.

• Event: records the operations that ROS performs when creating the resource
stack. The causes of failed operations are also displayed in the list.

• Template: displays the original template of the stack.

6
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2 Deploy LNMP
2.1 Use ROS

An LNMP environment is based on four major components required in this

architecture: Linux, NGINX, MySQL, and PHP. This topic describes how to use

Alibaba Cloud Resource Orchestration Service (ROS) to eﬃciently deploy the LNMP
environment.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

ROS is a free service. You do not need to download or install any package. You can

use ROS to create resource stack templates in JSON format. In the ROS console, you

can also use a sample template to create a resource stack. For more information, see
Sample Template. For example, you can use the LNMP_basic template in the ROS

console to automatically create an ECS instance, and deploy the LNMP environment
on this instance.

You can also use other sample templates in the ROS console to build other

environments, such as Java Web test environments, Node.js development and test

environments, Ruby Web development and test environments, or Hadoop and Spark
distributed systems.

For more information about ROS, see ROS documentation.

Procedure

1. Log on to the ROS console.
Note:

The ﬁrst time that you use the ROS service, you are prompted to activate this
service. ROS is a free service, so you can activate ROS free of charge.

2. In the left-side navigation pane, choose Key Help > ECS Instance Information, click
the ECS Instance Type tab to ﬁnd the target instance type in the Instance Type

Issue: 20190919

7

Elastic Compute Service

Tutorials / 2 Deploy LNMP

column, click the ECS Zone tab to ﬁnd the target zone ID in the ZoneId column,
and then click the ECS Image tab to ﬁnd the target image ID in the Image
column.

List

3. In the left-side navigation pane, click Sample Template.
4. Find the sample template LNMP_basic.

5. Click Preview to check the template in JSON format. The following table lists the
top-level ﬁelds in the JSON ﬁle.
Top-level ﬁeld

" ROSTemplat

eFormatVer

" 2015 - 09 - 01 "

sion " : Speciﬁes the version of the template.

" Descriptio n ": " Deploy
LNMP ( Linux + Nginx + MySQL +
PHP ) stack
on
1
ECS
instance . ***
WARNING ***
Only
support
CentOS - 7 ."
" Parameters " : { }

Description

Describes the use of the template.

Speciﬁes some parameters. In this
example, this ﬁeld speciﬁes the default
image ID and instance type.

" Resources " : { }

Speciﬁes the resources that you can use
the template to create. In this example,
this ﬁeld speciﬁes that the resources
to be created include an ECS instance
and a security group. The properties
of these resources are deﬁned in the
Parameters ﬁeld.

8
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Description

Speciﬁes the resource information that
the stack outputs after ROS creates the

speciﬁed resources. In this example,
the stack outputs the ECS instance ID,
public IP address, and security group ID
.

7. Select the region where the ECS instance is located from the Region drop-down list,
such as China (Hangzhou), and click Next.

8. Set stack parameters, and click Create.

• Stack Name: speciﬁes a unique stack name. You cannot change the stack name
after ROS creates the stack.

• Creation timeout (minutes): speciﬁes a period. If ROS fails to create the speciﬁed
resources within the period, the creation operation will time out. You can select
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or clear Roll back. If you select Roll back, ROS will delete the created resources
when an error such as creation timeout occurs during the creation process.

• Nginx Download Url: speciﬁes the default NGINX download URL.

• DB Password and (Please Conﬁrm) DB Password: specify the password for

accessing a MySQL database and conﬁrm the password. The password must
contain only letters and digits.

• The ECS Available Zone ID: the zone ID of the resource that you want to create.
For more information, see Step 2.

• ECS Image Id: the ID of the image that ROS uses to create the ECS instance. For
more information, see Step 2.

• DB Name: the name of the MySQL database.

• DB Username: the username of the MySQL database.

• DB Root Password and (Please Conﬁrm) DB Root Password: specify the password
of a MySQL root user and conﬁrm the password. The password must contain
only letters and digits.

• ECS Instance Type: the type of the ECS instance that you want to create. For
more information, see Step 2.

• System Disk Category: the type of the disk.

• Instance Password and (Please Conﬁrm) Instance Password: specify the

password for logon to the ECS instance and conﬁrm the password. The password
must contain only letters and digits.

10
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9. In the left-side navigation pane, click Stack Management to check the state of the
stack that you have created.
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10.Click the name of the created stack. In the Output section on the Stack Overview
page, check the value of NginxWebsi

teURL . You can use the URL to connect to

the LNMP environment that you have created.

Note:

• On the Resource List page, you can check all resources of the stack.

• On the Event List page, you can check the operations that ROS performs in the

process of creating the stack. The causes of failed operations are also displayed
in the list.

• On the Stack Template page, you can check the original template of the stack.

2.2 Build LNMP environment under CentOS 6

This article describes how to build LNMP environment under CentOS on an ECS
instance with the basic conﬁguration.

• Linux: A family of free and open-source UNIX-like software operating systems (OS).
• Nginx: A lightweight HTTP and reverse proxy server.
• MySQL: A relational database management system.

• PHP: A scripting language that is especially suited for web development.

Audience

This method is applicable to individual users who are familiar with Linux, but new to
website construction by using Alibaba Cloud ECS.

Procedure
12

Follow these steps to build LNMP environment on an ECS instance:
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1. Prepare the compiling environment.
2. Install Nginx.

3. Install MySQL.
4. Install MySQL.
5. Test.

Step 1: Prepare the compiling environment

Follow these steps to prepare the compiling environment. You can also buy LNMP
images at the Cloud Market to start your ECS instance for website quick building.
1. Check the version of the operating system.

# cat / etc / redhat - release
CentOS
release
6 . 5 ( Final )
Note:

This article is based on a Linux instance running CentOS 6.5. You may have

diﬀerent OS versions. The same is applicable to the Nginx, MySQL, and PHP
versions mentioned in the following paragraphs.

2. Disable SELINUX.

Run the command to modify the conﬁguration ﬁle, which permanently takes eﬀect
after you restart the service.

# sed - i ' s / SELINUX =. */ SELINUX = disabled / g ' / etc /
selinux / config
Run the command to make the conﬁguration take eﬀect immediately.
#

setenforce

0

3. Security group setting.

Add a security rule to accept Internet access to the Web server on the instance.

Step 2: Install Nginx

Nginx is a small and highly-eﬃcient Web server based on Linux. Follow these steps to
install Nginx:

1. Add a user to run the Nginx service process.
#

groupadd
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- r

- g

nginx

nginx

2. Download the source code package, decompress it, and then compile.
# wget
http :// nginx . org / download / nginx - 1 . 10 . 2 . tar
. gz
# tar
xvf
nginx - 1 . 10 . 2 . tar . gz - C / usr / local /
src
# yum
groupinsta ll " Developmen t
tools "
# yum - y
install
gcc
wget
gcc - c ++ automake
autoconf
libtool
libxml2 - devel
libxslt - devel
perl - devel
perl
- ExtUtils - Embed
pcre - devel
openssl - devel
# cd / usr / local / src / nginx - 1 . 10 . 2
# ./ configure \
-- prefix =/ usr / local / nginx \
-- sbin - path =/ usr / sbin / nginx \
-- conf - path =/ etc / nginx / nginx . conf \
-- error - log - path =/ var / log / nginx / error . log \
-- http - log - path =/ var / log / nginx / access . log \
-- pid - path =/ var / run / nginx . pid \
-- lock - path =/ var / run / nginx . lock \
-- http - client - body - temp - path =/ var / tmp / nginx / client
\
-- http - proxy - temp - path =/ var / tmp / nginx / proxy \
-- http - fastcgi - temp - path =/ var / tmp / nginx / fcgi \
-- http - uwsgi - temp - path =/ var / tmp / nginx / uwsgi \
-- http - scgi - temp - path =/ var / tmp / nginx / scgi \
-- user = nginx \
-- group = nginx \
-- with - pcre \
-- with - http_v2_mo dule \
-- with - http_ssl_m odule \
-- with - http_reali p_module \
-- with - http_addit ion_module \
-- with - http_sub_m odule \
-- with - http_dav_m odule \
-- with - http_flv_m odule \
-- with - http_mp4_m odule \
-- with - http_gunzi p_module \
-- with - http_gzip_ static_mod ule \
-- with - http_rando m_index_mo dule \
-- with - http_secur e_link_mod ule \
-- with - http_stub_ status_mod ule \
-- with - http_auth_ request_mo dule \
-- with - mail \
-- with - mail_ssl_m odule \
-- with - file - aio \
-- with - ipv6 \
-- with - http_v2_mo dule \
-- with - threads \
-- with - stream \
-- with - stream_ssl _module
# make && make
install
# mkdir - pv / var / tmp / nginx / client
3. Add a SysV startup script.
# vim / etc / init . d / nginx
#!/ bin / sh
#
# nginx - this
script
starts
daemon
#
14

and

stops

the

nginx
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# chkconfig :
- 85
15
# descriptio n : Nginx
is
an
HTTP ( S ) server , HTTP ( S
) reverse \
#
proxy
and
IMAP / POP3
proxy
server
# processnam e : nginx
# config :
/ etc / nginx / nginx . conf
# config :
/ etc / sysconfig / nginx
# pidfile :
/ var / run / nginx . pid
# Source
function
library .
. / etc / rc . d / init . d / functions
# Source
networking
configurat ion .
. / etc / sysconfig / network
# Check
that
networking
is
up .
[ "$ NETWORKING " = " no " ] && exit
0
nginx ="/ usr / sbin / nginx "
prog =$( basename $ nginx )
NGINX_CONF _FILE ="/ etc / nginx / nginx . conf "
[ - f / etc / sysconfig / nginx ] && . / etc / sysconfig / nginx
lockfile =/ var / lock / subsys / nginx
start () {
[ - x $ nginx ] || exit
5
[ - f $ NGINX_CONF _FILE ] || exit
6
echo - n $" Starting $ prog : "
daemon $ nginx - c $ NGINX_CONF _FILE
retval =$?
echo
[ $ retval - eq
0 ] && touch $ lockfile
return $ retval
}
stop () {
echo - n $" Stopping $ prog : "
killproc $ prog - QUIT
retval =$?
echo
[ $ retval - eq
0 ] && rm - f $ lockfile
return $ retval
killall - 9
nginx
}
restart () {
configtest || return $?
stop
sleep
1
start
}
reload () {
configtest || return $?
echo - n $" Reloading $ prog : "
killproc $ nginx - HUP
RETVAL =$?
echo
}
force_relo ad () {
restart
}
configtest () {
$ nginx - t - c $ NGINX_CONF _FILE
}
rh_status () {
status $ prog
}
rh_status_ q () {
rh_status >/ dev / null
2 >& 1
}
case "$ 1 " in
Issue: 20190919
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start )
rh_status_ q && exit
0
$ 1
;;
stop )
rh_status_ q || exit
0
$ 1
;;
restart | configtest )
$ 1
;;
reload )
rh_status_ q || exit
7
$ 1
;;
force - reload )
force_relo ad
;;
status )
rh_status
;;
condrestar t | try - restart )
rh_status_ q || exit
0
;;
*)
echo $" Usage : $ 0 { start | stop | status | restart
| condrestar t | try - restart | reload | force - reload |
configtest }"
exit
2
esac
4. Grant the permission to run the script.
#

chmod

+ x

/ etc / init . d / nginx

5. Add Nginx to the service management list, and set it to automatically start on
startup.
#

16

chkconfig

-- add

nginx
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chkconfig

nginx

on

6. Start the service.
#

service

nginx

start

7. Access the instance by using http://Public IP address. If the following page
appears, Nginx is installed successfully.

Step3: Install MySQL

1. Prepare the compiling environment.
# yum
groupinsta ll " Server
Developmen t
tools " - y
# yum
install
cmake - y

Platform

Developmen

t "

"

2. Create a directory to store the data of MySQL.
#
#
#
#

mkdir / mnt / data
groupadd - r
mysql
useradd - r - g
mysql
id
mysql

Issue: 20190919

- s

/ sbin / nologin

mysql

17

Elastic Compute Service

Tutorials / 2 Deploy LNMP

uid = 497 ( mysql )

gid = 498 ( mysql )

groups = 498 ( mysql )

3. Change the owner and group of the data directory.
#

chown

- R

mysql : mysql

/ mnt / data

4. Decompress and compile the stable source code package downloaded from MySQL
oﬃcial website. In this article, we use version 5.6.24.

# tar
xvf
mysql - 5 . 6 . 24 . tar . gz - C
/ usr / local /
src
# cd / usr / local / src / mysql - 5 . 6 . 24
# cmake . - DCMAKE_INS TALL_PREFI X =/ usr / local / mysql \
- DMYSQL_DAT ADIR =/ mnt / data \
- DSYSCONFDI R =/ etc \
- DWITH_INNO BASE_STORA GE_ENGINE = 1 \
- DWITH_ARCH IVE_STORAG E_ENGINE = 1 \
- DWITH_BLAC KHOLE_STOR AGE_ENGINE = 1 \
- DWITH_READ LINE = 1 \
- DWITH_SSL = system \
- DWITH_ZLIB = system \
- DWITH_LIBW RAP = 0 \
- DMYSQL_TCP _PORT = 3306 \
- DMYSQL_UNI X_ADDR =/ tmp / mysql . sock \
- DDEFAULT_C HARSET = utf8 \
- DDEFAULT_C OLLATION = utf8_gener al_ci
# make && make
install
5. Change the group of the installation directory to mysql.
#

chown

- R

mysql : mysql

/ usr / local / mysql /

6. Initializes the database.
# / usr / local / mysql / scripts / mysql_inst
mysql -- datadir =/ mnt / data /

all_db

-- user =

Note:

After completing the minimum installation of the CentOS 6.5 operating system,

a my.cnf ﬁle is generated under the /etc directory. You must rename this ﬁle. For

example, rename it as /etc/my.cnf.bak. Otherwise, this ﬁle will interfere with the

correct conﬁguration for MySQL source code installation, leading to MySQL start
failure.

7. Copy the conﬁguration ﬁle and startup script.
# cp / usr / local / mysql / support - files / mysql . server
etc / init . d / mysqld
# chmod + x / etc / init . d / mysqld
# cp
support - files / my - default . cnf / etc / my . cnf

/

8. Set automatic start on startup.
#
18

chkconfig

mysqld

on
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-- add

mysqld

9. Modify the installation path and data storage path in the conﬁguration ﬁle.
# echo - e " basedir = / usr / local / mysql \ ndatadir
/ data \ n " >> / etc / my . cnf

= / mnt

10.Set the PATH environment variable.
# echo " export
PATH =$ PATH :/ usr / local / mysql / bin " > /
etc / profile . d / mysql . sh
# source / etc / profile . d / mysql . sh
11.Start the service.
#
#

service
mysqld
start
mysql - h
127 . 0 . 0 . 1

Step 4: Install PHP-FPM

Nginx cannot process PHP. As a Web server, when Nginx receives a request, it does

not support directly calling or parsing the external program. It must use FastCGI to

call such programs. However, in case of PHP requests, Nginx will transfer the request

to a PHP interpreter, and return the result to the client. PHP-FPM is a FastCGI process
manager that supports parsing PHP code. PHP-FPM provides better PHP process

management methods, which can eﬀectively control the memory and process, and
can support smoothly reloading PHP conﬁguration.
1. Install dependency package.
# yum
devel

install
libxml2

libmcrypt
libmcrypt - devel
mhash
mhash libxml2 - devel
bzip2
bzip2 - devel

2. Decompress the source code package downloaded from the oﬃcial website, and
then compile and install it.

# tar
xvf
php - 5 . 6 . 23 . tar . bz2 - C / usr / local /
src
# cd / usr / local / src / php - 5 . 6 . 23
# ./ configure -- prefix =/ usr / local / php \
-- with - config - file - scan - dir =/ etc / php . d \
-- with - config - file - path =/ etc \
-- with - mysql =/ usr / local / mysql \
-- with - mysqli =/ usr / local / mysql / bin / mysql_conf ig \
-- enable - mbstring \
-- with - freetype - dir \
-- with - jpeg - dir \
-- with - png - dir \
-- with - zlib \
-- with - libxml - dir =/ usr \
-- with - openssl \
-- enable - xml \
-- enable - sockets \
-- enable - fpm \
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-- with - mcrypt \
-- with - bz2
# make && make
install
3. Add the PHP and PHP-FPM conﬁguration ﬁles.
# cp / usr / local / src
production / etc / php .
# cd / usr / local / php
# cp
php - fpm . conf .
# sed - i ' s @; pid =
local / php / var / run /

/ php - 5 . 6 . 23 / php . ini ini
/ etc /
default
php - fpm . conf
run / php - fpm . pid @ pid = / usr /
php - fpm . pid @' php - fpm . conf

4. Add the PHP-FPM startup script.
# cp / usr / local / src / php - 5 . 6 . 23 / sapi / fpm / init .
d . php - fpm / etc / init . d / php - fpm
# chmod + x / etc / init . d / php - fpm
5. Add PHP-FPM to the service list, and set it to automatically start on startup.
#
#
#

chkconfig
chkconfig
chkconfig

-- add
php - fpm
-- list
php - fpm
php - fpm
on

6. Start the service.
#

service

php - fpm

start

7. Follow these steps to conﬁgure Nginx to support fastcgi: Back up the default
conﬁguration ﬁle.

# cp / etc / nginx / nginx . conf / etc / nginx / nginx .
confbak
# cp / etc / nginx / nginx . conf . default / etc / nginx / nginx
. conf
Edit /etc/nginx/nginx.conf: Add a home page in the PHP format into the supported
home page formats as follows.
location
root
index
}

/ {
/ usr / local / nginx / html ;
index . php
index . html
index . htm ;

Delete comments in front of the following content.
location ~ \. php $ {
root
/ usr / local / nginx / html ;
fastcgi_pa ss
127 . 0 . 0 . 1 : 9000 ;
fastcgi_in dex
index . php ;
fastcgi_pa ram
SCRIPT_FIL ENAME
/ usr / local / nginx /
html /$ fastcgi_sc ript_name ;
include
fastcgi_pa rams ;

20
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}
Reload the Nginx conﬁguration ﬁle.
#

service

nginx

reload

Create an index.php test page under /usr/local/nginx/html/, the content of which is
shown as follows.

# cat
index . php
<? php
$ conn = mysql_conn ect (' 127 . 0 . 0 . 1 ',' root ','');
if ($ conn ){
echo " LNMP
platform
connect
to
mysql
is
successful
!";
} else {
echo " LNMP
platform
connect
to
mysql
is
failed !";
}
phpinfo ();
?>
Access the instance by using http://Public IP address/index.php. If the following
page appears, LNMP environment is built successfully.

2.3 Build an LNMP environment on CentOS 7

NGINX is a small and eﬃcient Web server software for Linux. NGINX allows you to
easily build an LNMP Web service environment. The LNMP environment is based

on four major components required in this architecture: Linux, NGINX, MySQL, and
PHP. This topic describes how to manually build the LNMP environment on an ECS
instance.

Prerequisites

• You must have an Alibaba Cloud account before you follow the instructions

provided in the tutorial. To create an Alibaba Cloud account, click Create an
Alibaba Cloud account.
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• You have added an inbound rule to the security group of the ECS instance to
support Ports 80 and 3306. For more information, see #unique_10.

Context

The procedure described in this topic is applicable to individual users that are

familiar with Linux, but new to website construction by using Alibaba Cloud ECS
instances.

The following software versions are used:

• Operating system: public image 64-bit CentOS 7.2
• NGINX: version 1.12.2

• MySQL: version 5.7.25
• PHP: version 7.0.33

The ECS instances described in this topic use the following conﬁgurations:
• CPU: 2 vCPUs

• Memory: 4 GiB

• Network type: Virtual Private Cloud (VPC)
• IP address: public IP address

You can also purchase an LNMP image in Alibaba Cloud Marketplace and launch an
ECS instance from the image to eﬃciently build a website.

Procedure

To build an LNMP environment manually by using an ECS instance, follow these
steps:

1. Step 1: Prepare the compiling environment
2. Step 2: Install NGINX

3. Step 3: Install MySQL
4. Step 4: Install PHP

5. Step 5: Conﬁgure NGINX

6. Step 6: Conﬁgure MySQL
7. Step 7: Conﬁgure PHP

8. Step 8: Test the connection to the LNMP environment

Step 1: Prepare the compiling environment
22

To prepare the compiling environment, follow these steps:
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1. Connect to a Linux ECS instance. For more information, see #unique_11 or
#unique_12.

2. Disable the ﬁrewall.

a) Run the command systemctl
the ﬁrewall.

status

firewalld to check the state of

• If the ﬁrewall stays in the inactive state, the ﬁrewall is disabled.

• If the ﬁrewall stays in the active state, the ﬁrewall is enabled. In this

example, the ﬁrewall is in the active state, so you must disable the ﬁrewall.

b) Disable the ﬁrewall. Skip this step if the ﬁrewall is in the inactive state.
• To temporarily disable the ﬁrewall, run the command systemctl
firewalld .

stop

Note:

Therefore, the ﬁrewall is temporarily disabled, and will remain in the active
state when you restart Linux next time.

• To permanently disable the ﬁrewall, run the command systemctl
disable

firewalld .

Note:

You can enable the ﬁrewall again. For more information, see Firewalld
documentation.
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3. Disable Security-Enhanced Linux (SELinux).

a) Run the getenforce command to check the state of SELinux.

• If SELinux stays in the Disabled state, SELinux is disabled.

• If SELinux stays in the Enforcing state, SELinux is enabled. In this

example, SELinux is in the Enforcing state, so you must disable SELinux.

b) Disable SELinux. Skip this step if SELinux is in the Disabled state.

• To temporarily disable SELinux, run the command setenforce

0 .

Note:

Therefore, SELinux is temporarily disabled, and will remain in the Enforcing
state when you restart Linux next time.

• To permanently disable SELinux, follow these steps: Run the command vi
/ etc / selinux / config , and press the Enter key. Move the pointer

to the line of SELINUX = enforcing , and press the i key to enter the edit
mode. Edit the SELinux state in this way: SELINUX = disabled . Afterward,
press the Esc key, type : wq , and then press the Enter key to save and
close the SELinux conﬁguration ﬁle.
Note:

You can enable SELinux again. For more information, see SELinux
documentation.

c) Restart the system to make the changes take eﬀect.

Step 2: Install NGINX

To install NGINX, follow these steps:

24
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1. Run the following command to install NGINX.
yum

- y

install

nginx

2. Run the following command to check the NGINX version.
nginx

- v

The following response indicates that NGINX has been installed.
nginx

version :

nginx / 1 . 12 . 2

Step 3: Install MySQL

To install MySQL, follow these steps:

1. Run the following command to update the YUM repository.
rpm - Uvh
http :// dev . mysql . com / get / mysql57 community - release - el7 - 9 . noarch . rpm
2. Run the following command to install MySQL.
yum

- y

install

mysql - community - server

3. Run the following command to check the MySQL version.
mysql

- V

The following response indicates that MySQL has been installed.
mysql
Ver
14 . 14
Distrib
5 . 7 . 25 ,
x86_64 ) using
EditLine
wrapper

for

Linux

(

Step 4: Install PHP

To install PHP, follow these steps:

1. Run the following commands in sequence to update the YUM repository.
# yum
install - y
http :// dl . iuscommuni ty . org / pub /
ius / stable / CentOS / 7 / x86_64 / ius - release - 1 . 0 - 15 .
ius . centos7 . noarch . rpm
# rpm - Uvh
https :// mirror . webtatic . com / yum / el7 /
webtatic - release . rpm
Note:

The package ius - release - 1 . 0 - 15 . ius . centos7 . noarch .

rpm is used in this topic. In your actual running environment, use the latest ius-

release package.
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2. Run the following command to install PHP.
yum - y
install
php70w - devel
php70w . x86_64
php70w
- cli . x86_64
php70w - common . x86_64
php70w - gd . x86_64
php70w - ldap . x86_64
php70w - mbstring . x86_64
php70w mcrypt . x86_64
php70w - pdo . x86_64
php70w - mysqlnd
php70w - fpm
php70w - opcache
php70w - pecl - redis
php70w pecl - mongo
3. Run the following command to check the PHP version.
php

- v

The following response indicates that PHP has been installed.
PHP
7 . 0 . 33 ( cli ) ( built : Dec
6
2018
22 : 30 : 44
) ( NTS )
Copyright ( c ) 1997 - 2017
The
PHP
Group
Zend
Engine
v3 . 0 . 0 , Copyright ( c ) 1998 - 2017
Zend
Technologi es
with
Zend
OPcache
v7 . 0 . 33 , Copyright ( c ) 1999 2017 , by
Zend
Technologi es
Step 5: Conﬁgure NGINX

To conﬁgure NGINX, follow these steps:

1. Run the following command to back up the NGINX conﬁguration ﬁle.
cp / etc / nginx / nginx . conf
bak

/ etc / nginx / nginx . conf .

2. Run the following command to open the NGINX conﬁguration ﬁle.
vim

/ etc / nginx / nginx . conf

3. Press the i key to enter the edit mode.

4. Add the following conﬁgurations between the braces of the server ﬁeld so that
NGINX can support PHP requests.

location / {
index
index . php

index . html
index . htm ;
}
# Enables
NGINX
to
process
your
PHP
requests
by
using
Fast
Common
Gateway
Interface ( FastCGI ).
location ~ . php $ {
root / usr / share / php ;
fastcgi_pa ss
127 . 0 . 0 . 1 : 9000 ; # NGINX
forwards
PHP
requests
to
PHP
FastCGI
Process
Manager
( PHP - FPM ) through
Port
9000
of
the
ECS
instance .
fastcgi_in dex
index . php ;
fastcgi_pa ram
SCRIPT_FIL ENAME
$ document_r
oot $ fastcgi_sc ript_name ;
include
fastcgi_pa rams ; # NGINX
uses
the
FastCGI
interface
to
process
PHP
requests .
26
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}
Note:

If you do not add the conﬁgurations, NGINX cannot process your PHP requests. As
a result, you will not open the requested PHP-enabled page.

5. Run the following command to start the NGINX service.
systemctl

start

nginx

6. Run the following command to enable the NGINX service to run at startup.
systemctl

enable

nginx

Step 6: Conﬁgure MySQL

To conﬁgure MySQL, follow these steps:

1. Run the following command to start the MySQL service.
systemctl

start

mysqld

2. Run the following command to enable the MySQL service to run at startup.
systemctl

enable

mysqld

3. Run the following command to check the ﬁle / var / log / mysqld . log and
obtain the initial password of the root user.

# grep ' temporary
password ' / var / log / mysqld . log
2016 - 12 - 13T14 : 57 : 47 . 535748Z
1 [ Note ] A
temporary
password
is
generated
for
root @ localhost : p0 / G28g >
lsHD
Note:

You must use the initial password to reset the password as the root user.

4. Run the following command to conﬁgure your MySQL databases and secure data.
mysql_secu

re_install

ation

Continue with these steps for the security conﬁguration:
a) Reset the password as the root user.

Enter
password
for
user
root : # Specifies
the
initial
password
that
you
obtained
in
the
previous
step .
The ' validate_p assword ' plugin
is
installed
on
the
server .
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The
subsequent
steps
will
run
with
the
existing
configurat ion
of
the
plugin .
Using
existing
password
for
root .
Estimated
strength
of
the
password : 100
Change
the
password
for
root ? (( Press
y | Y
for
Yes , any
other
key
for
No ) : Y # Specifies
whether
to
change
the
password
of
the
root
user . Press
the
Y
key .
New
password : # Specifies
a
new
password . The
password
must
be
8
to
30
characters
in
length
and
must
contain
letters , digits , and
special
characters
at
the
same
time . The
following
special
characters
are
allowed : parenthese s (()), grave
accents (`), tildes (~), exclamatio n
points (!), at
signs (@), number
signs (#), dollar
signs ($), percent
signs (%), carets (^), ampersands (&), asterisks (*),
hyphens (-), underscore s ( _ ), plus
signs (+), equal
signs (=), vertical
bars (|), braces ({}), brackets
([]), colons (:), semicolons (;), apostrophe s ('), angle
brackets (<>), commas (,), periods (.), question
marks
(?), and
forward
slashes (/).
Re - enter
new
password : # Confirms
the
new
password .
Estimated
strength
of
the
password : 100
Do
you
wish
to
continue
with
the
password
provided ?( Press
y | Y
for
Yes , any
other
key
for
No ) : Y
b) Press the Y key to delete anonymous users.
By
default , a
MySQL
installati on
has
an
anonymous
user , allowing
anyone
to
log
into
MySQL
without
having
to
have
a
user
account
created
for
them
. This
is
intended
only
for
testing , and
to
make
the
installati on
go
a
bit
smoother . You
should
remove
them
before
moving
into
a
production
environmen t .
Remove
anonymous
users ? ( Press
y | Y
for
Yes , any
other
key
for
No ) : Y
# Specifies
whether
to
delete
anonymous
users . Press
the
Y
key .
Success .
c) Press the Y key to disable remote logon as the root user.
Disallow
root
login
remotely ? ( Press
y | Y
for
Yes
, any
other
key
for
No ) : Y # Specifies
whether
to
disable
remote
logon
as
a
root
user . Press
the
Y
key .
Success .
d) Press the Y key to delete the test database and the permission for accessing
the test database.

Remove
test
database
and
access
to
it ? ( Press
y |
Y
for
Yes , any
other
key
for
No ) : Y # Specifies
whether
to
delete
the
test
database
and
the
permission
for
accessing
the
test
database . Press
the
Y
key .
- Dropping
test
database ...
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Success .
e) Press the Y key to reload the grant table.
Reload
privilege
tables
now ? ( Press
y | Y
, any
other
key
for
No ) : Y # Specifies
to
reload
the
grant
table . Press
the
Y
Success .
All
done !

for
Yes
whether
key .

For more information, see MySQL documentation.

Step 7: Conﬁgure PHP

To conﬁgure PHP, follow these steps:

1. In the / usr / share / php directory, create a phpinfo . php ﬁle to show
PHP version information. Continue with these steps:
a) Run the command vim

/ usr / share / php / phpinfo . php to open the

ﬁle.

b) Press the i key to enter the edit mode.
c) Enter the following code:
<?

php

echo

phpinfo (); ? >

d) Type : wq to save and close the ﬁle.

2. Run the following command to start PHP-FPM.
systemctl

start

php - fpm

3. Run the following command to enable PHP-FPM to run at startup.
systemctl

enable

php - fpm

Step 8: Test the connection to the LNMP environment

To test the connection to the LNMP environment, follow these steps:
1. Open your browser.
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2. In the address bar, enter the URL http ://< Public
the

ECS

instance >/ phpinfo . php .

IP

address

of

The following response indicates that the LNMP environment has been deployed.

What's next

Afterward, we recommend that you run the following command to delete / usr /
share / php / phpinfo . php and secure your system.
rm

30
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/ usr / share / php / phpinfo . php
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3 Conﬁgure Java Web
3.1 Deploy a Java Web project

This article describes how to deploy a Java Web project on a Linux instance with the
basic conﬁguration. This method is applicable to individual users who are new to
website construction by using ECS.

Conﬁguration requirements

The following programs are used as examples to deploy the Java Web project:
• OS: CentOS 7.4

• Tomcat: Tomcat 8.5.23
• JDK: JDK 1.8.0_141

Preparations

• The ﬁrewall is enabled by default for CentOS 7.4. You can disable the ﬁrewall, or

add rules on the ﬁrewall by referring to oﬃcial documents to open Ports 80, 443, or
8080 for inbound access.
- Disable the ﬁrewall.
systemctl

stop

firewalld . service

- Set the ﬁrewall not to be enabled automatically at startup.
systemctl

disable

firewalld . service

• Create a user www to run Tomcat.
useradd

www

• Add a security group rule to open Port 8080 for HTTP access. For more
information, see add a security group rule.

• Creates a root directory for the Java Web project.
mkdir

- p

/ data / wwwroot / default

• Create a Tomcat test page.
echo
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www . www

/ data / wwwroot

Download source code
wget
https :// mirrors . aliyun . com / apache / tomcat / tomcat 8 / v8 . 5 . 23 / bin / apache - tomcat - 8 . 5 . 23 . tar . gz
The source code is constantly upgraded. You can ﬁnd the installation package at
https :// mirrors . aliyun . com / apache / tomcat / tomcat - 8 /.

wget
http :// mirrors . linuxeye . com / jdk / jdk - 8u141 - linux
- x64 . tar . gz
The source code is constantly upgraded. You can ﬁnd the installation package at
http :// mirrors . linuxeye . com / jdk /.

Install JDK

To install JDK, follow these steps:

1. Run mkdir /usr/java to create a directory.
mkdir

/ usr / java

2. Run the following command to decompress jdk-8u141-linux-x64.tar.gz to the / usr
/ java directory.
tar
java

xzf

jdk - 8u141 - linux - x64 . tar . gz

- C

/ usr /

3. Follow these steps to set environment variables:
a. Run vi /etc/proﬁle: vi

/ etc / profile

b. Press the i key to enter the Edit mode.

c. Add the following lines into the /etc/proﬁle ﬁle:
# set
java
environmen t
export
JAVA_HOME =/ usr / java / jdk1 . 8 . 0_141
export
CLASSPATH =$ JAVA_HOME / lib / tools . jar :$ JAVA_HOME
/ lib / dt . jar :$ JAVA_HOME / lib
export
PATH =$ JAVA_HOME / bin :$ PATH
d. Press the Esc key, and then type : wq to save and close the ﬁle.

4. Run source
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/ etc / profile to load the new environment variable.
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5. Check the version of JDK. When the JDK version is displayed, it indicates that JDK
has been installed successfully.
java

- version

java - version
java
version " 1 . 8 . 0_141 "
Java ( TM ) SE
Runtime
Environmen t
- b15 )
Java
HotSpot ( TM ) 64 - Bit
Server
b15 , mixed
mode )

( build
VM

1 . 8 . 0_141

( build

25 . 141 -

Install Tomcat

To install Tomcat, follow these steps:

1. Run the following commands one by one to decompress apache-

tomcat-8.5.23.tar.gz, rename the Tomcat directory, and set user permissions.
tar
xzf
apache - tomcat - 8 . 5 . 23 . tar . gz
mv
apache - tomcat - 8 . 5 . 23 / usr / local / tomcat /
chown - R
www . www / usr / local / tomcat /
Note:

In the /usr/local/tomcat/ directory:

• The bin directory stores some Tomcat script ﬁles, including scripts for enabling
and disabling Tomcat service.

• The conf directory stores various global conﬁguration ﬁles for Tomcat server,
the most important of which are server.xml and web.xml.

• The webapps directory is the main Web publishing directory of Tomcat, which
stores Web application ﬁles by default.

• The logs directory stores Tomcat log ﬁles.
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2. Follow these steps to conﬁgure the server.xml ﬁle:

a. Switch to the /usr/local/tomcat/conf/ directory: cd
/ conf /.

b. Rename the server.xml ﬁle: mv
c. Create a new server.xml ﬁle:
A. Run vi

server . xml

/ usr / local / tomcat
server . xml_bk .

server . xml .

B. Press the i key to enter the Edit mode.
C. Add the following content.

<? xml
version =" 1 . 0 " encoding =" UTF - 8 "? > < Server
port =" 8006 " shutdown =" SHUTDOWN "> < Listener
className
=" org . apache . catalina . core . JreMemoryL eakPrevent
ionListene r "/> < Listener
className =" org . apache .
catalina . mbeans . GlobalReso urcesLifec ycleListen er
"/> < Listener
className =" org . apache . catalina . core
. ThreadLoca lLeakPreve ntionListe ner "/> < Listener
className =" org . apache . catalina . core . AprLifecyc
leListener "/> < GlobalNami ngResource s > < Resource
name
=" UserDataba se " auth =" Container " type =" org . apache
. catalina . UserDataba se " descriptio n =" User
database
that
can
be
updated
and
saved " factory =" org
. apache . catalina . users . MemoryUser DatabaseFa ctory
" pathname =" conf / tomcat - users . xml "/> </ GlobalNami
ngResource s > < Service
name =" Catalina "> < Connector
port =" 8080 " protocol =" HTTP / 1 . 1 " connection Timeout
=" 20000 " redirectPo rt =" 8443 " maxThreads =" 1000 "
minSpareTh reads =" 20 " acceptCoun t =" 1000 " maxHttpHea
derSize =" 65536 " debug =" 0 " disableUpl oadTimeout =" true
" useBodyEnc odingForUR I =" true " enableLook ups =" false
" URIEncodin g =" UTF - 8 "/> < Engine
name =" Catalina "
defaultHos t =" localhost "> < Realm
className =" org . apache
. catalina . realm . LockOutRea lm "> < Realm
className =" org
. apache . catalina . realm . UserDataba seRealm " resourceNa
me =" UserDataba se "/> </ Realm > < Host
name =" localhost
" appBase ="/ data / wwwroot / default " unpackWARs =" true
" autoDeploy =" true "> < Context
path ="" docBase ="/ data
/ wwwroot / default " debug =" 0 " reloadable =" false "
crossConte xt =" true "/> < Valve
className =" org . apache
. catalina . valves . AccessLogV alve " directory =" logs "
prefix =" localhost_ access_log ." suffix =". txt " pattern
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="% h % l % u % t & quot ;% r & quot ; % s
> </ Engine > </ Service > </ Server >

% b " /> </ Host

3. Follow these steps to set JVM memory parameters:
a. Run vi

/ usr / local / tomcat / bin / setenv . sh .

b. Press the i key to enter the Edit mode.
c. Add the following content.

JAVA_OPTS ='- Djava . security . egd = file :/ dev /./ urandom
- server - Xms256m - Xmx496m - Dfile . encoding = UTF - 8 '
d. Press the Esc key, and then type : wq to save and close the ﬁle.

4. Follow these steps to set Tomcat automatic startup script:
a. Run the command to download the script: wget

https :// github . com /

lj2007331 / oneinstack / raw / master / init . d / Tomcat - init

b. Run the command to rename Tomcat-init: mv

Tomcat - init

/ etc /

init . d / tomcat

c. Add the permission: chmod

+ x

d. Set the startup script JAVA_HOME.

/ etc / init . d / tomcat

sed - i ' s @^ export
JAVA_HOME =.*@ export
JAVA_HOME =/
usr / java / jdk1 . 8 . 0_141 @' / etc / init . d / tomcat
5. Set automatic startup.
chkconfig
chkconfig

-- add
tomcat

tomcat
on

6. Start Tomcat.
service

tomcat

start

7. Access the instance by using http://Public IP address:8080. If the following page
appears, Tomcat is installed successfully.
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3.2 Use the Eclipse plug-in to deploy applications

Alibaba Cloud Toolkit for Eclipse (Cloud Toolkit) is a free plug-in used for integrated

development environment (IDE). After you develop, debug, and test an application on
the premises, you can use this plug-in to deploy the application to an ECS instance.

This topic describes how to use the Eclipse plug-in to deploy a Java application on an
ECS instance.

Prerequisites

• You have downloaded and installed Java Development Kit (JDK) 1.8 or later.

• You have downloaded and installed Eclipse IDE 4.5.0 or later. The program must be
suitable for Java Enterprise Edition (Java EE) developers.

• You must have an Alibaba Cloud account before you follow the instructions

provided in the tutorial. To create an Alibaba Cloud account, click Create an
Alibaba Cloud account.

Context

This topic describes how to install Cloud Toolkit in Eclipse on Windows, and eﬃcientl
y deploy an application by using Cloud Toolkit.

Procedure

To deploy a Java application by using the Eclipse plug-in on an ECS instance, follow
these steps:

1. Step 1: Install Cloud Toolkit

2. Step 2: Set the AccessKey pair

3. Step 3: Download and upload the JDK installation package
4. Step 4: Prepare for installation
5. Step 5: Install JDK

6. Step 6: Install Apache Tomcat

7. Step 7: Deploy a Java application to the ECS instance

Step 1: Install Cloud Toolkit

To install Cloud Toolkit, follow these steps:
1. Start Eclipse.
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2. On the menu, choose Help > Install New Software....

3. Click Add... in the window that appears.
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Toolkit

for

Eclipse and the software

location http :// toolkit . aliyun . com / eclipse , and click Add.

5. In the Name column, select Alibaba Cloud Toolkit Core and Alibaba Cloud Toolkit

Deployment Tools, and clear Contact all update sites during install to ﬁnd required
software in the Details section, and then click Next.

6. Click Next.
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7. Select I accept the terms of the license agreement, and click Finish.
8. Click Install anyway.

9. Click Restart Now to restart Eclipse.

Step 2: Set the AccessKey pair

The AccessKey ID and AccessKey Secret are issued to users by Alibaba Cloud. An

AccessKey ID is used to identify a user. An AccessKey Secret is used to encrypt the

signature string and is the key that the server uses to authenticate the signature string
. The AccessKey pair must be kept conﬁdential.

To set the AccessKey ID and AccessKey Secret, follow these steps:
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1. On the toolbar, choose Window > Preferences.

2. In the left-side navigation pane, choose Alibaba Cloud Toolkit > Accounts.
3. Enter the AccessKey ID and AccessKey Secret, and click Apply and Close.
Note:

• If you have an account but have not generated any AccessKey pair, click

Get existing AK/SK, and log on to the Alibaba Cloud console to generate an
AccessKey pair. For more information, see Create an AccessKey pair.
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• If you have not created any account, click Sign up.

Step 3: Download and upload the JDK installation package

To download and upload the JDK installation package, follow these steps:
1. Download Apache Tomcat.
Note:

The source code is constantly upgraded. You can click here to obtain the required
installation package address.

2. Download the JDK installation package.
Note:

If you download the JDK package on an ECS instance, an error occurs during

decompression. You can download the JDK installation package to your local
directory and upload the package to the ECS instance.

3. Log on to the ECS console.

4. In the left-side navigation pane, choose Instances & Images > Images.
Issue: 20190919
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5. In the top navigation bar, select a region.

6. Find the ECS instance, and obtain the public IP address of the instance from the IP
Address column.

7. Start Windows Secure Copy (WinSCP), use the public IP address to connect to

the Linux ECS instance, and then upload the JDK installation package to the root
directory of the Linux ECS instance.

Step 4: Prepare for installation

To prepare for installation, follow these steps:
1. #unique_17.

2. Add inbound rules to support the required ports. For more information, see
#unique_10.

3. Disable the ﬁrewall.

a) Run the command systemctl
the ﬁrewall.

status

firewalld to check the state of

• If the ﬁrewall stays in the inactive state, the ﬁrewall is disabled.

• If the ﬁrewall stays in the active state, the ﬁrewall is enabled. In this

example, the ﬁrewall is in the active state, so you must disable the ﬁrewall.

b) Disable the ﬁrewall. Skip this step if the ﬁrewall is in the inactive state.
• To temporarily disable the ﬁrewall, run the command systemctl
firewalld .

stop

Note:

Therefore, the ﬁrewall is temporarily disabled, and will remain in the active
state when you restart Linux next time.

• To permanently disable the ﬁrewall, run the command systemctl
disable

firewalld .

Note:
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You can enable the ﬁrewall again. For more information, see Firewalld
documentation.

4. Disable Security-Enhanced Linux (SELinux).

a) Run the getenforce command to check the state of SELinux.

• If SELinux stays in the Disabled state, SELinux is disabled.

• If SELinux stays in the Enforcing state, SELinux is enabled. In this

example, SELinux is in the Enforcing state, so you must disable SELinux.

b) Disable SELinux. Skip this step if SELinux is in the Disabled state.

• To temporarily disable SELinux, run the command setenforce

0 .

Note:

Therefore, SELinux is temporarily disabled, and will remain in the Enforcing
state when you restart Linux next time.

• To permanently disable SELinux, follow these steps: Run the command vi
/ etc / selinux / config , and press the Enter key. Move the pointer

to the line of SELINUX = enforcing , and press the i key to enter the edit
mode. Edit the SELinux state in this way: SELINUX = disabled . Afterward,
press the Esc key, type : wq , and then press the Enter key to save and
close the SELinux conﬁguration ﬁle.
Note:

You can enable SELinux again. For more information, see SELinux
documentation.

c) Restart the system to make the changes take eﬀect.
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5. Create a user named www to run Tomcat.
useradd

www

6. Creates a root directory for the Java Web project.
mkdir

- p

/ data / wwwroot / default

7. Assign the ﬁle permission under the root directory of the website to www.
chown

- R

www . www

/ data / wwwroot

Step 5: Install JDK

To install JDK, follow these steps:

1. Run mkdir /usr/java to create a directory.
mkdir

/ usr / java

2. Decompress the JDK installation package jdk - 8u191 - linux - x64 . tar .
gz in this example to / usr / java .
chmod + x
tar
xzf

jdk - 8u191 - linux - x64 . tar . gz
jdk - 8u191 - linux - x64 . tar . gz - C

3. Set environment variables.
a) Run the command vi

/ usr / java

/ etc / profile to open the / etc / profile ﬁle.

b) Press the i key to enter the edit mode.

c) Add the following lines into the / etc / profile ﬁle.
#

set
java
environmen t
export
JAVA_HOME =/ usr / java / jdk1 . 8 . 0_191
export
CLASSPATH =$ JAVA_HOME / lib / tools . jar :$ JAVA_HOME
/ lib / dt . jar :$ JAVA_HOME / lib
export
PATH =$ JAVA_HOME / bin :$ PATH

d) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.

4. Run the command source
5. Run the java

/ etc / profile to load environment variables.

- version command to check the JDK version.

The following response indicates that JDK has been installed.
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Step 6: Install Apache Tomcat

To install Apache Tomcat, follow these steps:

1. Run the following commands in sequence to decompress the package apache -

tomcat - 8 . 5 . 34 . tar . gz , rename the Tomcat directory, and then set

user permissions.

tar
xzf
apache - tomcat - 8 . 5 . 34 . tar . gz
mv
apache - tomcat - 8 . 5 . 34 / usr / local / tomcat /
chown - R
www . www / usr / local / tomcat /
The directory / usr / local / tomcat / contains the following ﬁles:

• The bin directory stores some Tomcat script ﬁles, including scripts for
enabling and disabling the Tomcat service.

• The conf directory stores various global conﬁguration ﬁles for the Tomcat
server, including the important ﬁles server . xml and web . xml .

• The webapps directory is the main Web publishing directory of Tomcat to
store Web application ﬁles by default.

• The logs directory stores Tomcat log ﬁles.

2. Conﬁgure the server . xml ﬁle.
a) Run the command cd

/ usr / local / tomcat / conf / to switch to the

directory / usr / local / tomcat / conf /.

b) Run the command mv
server . xml ﬁle.

c) Run the vi

server . xml

server . xml_bk to rename the

server . xml command.

d) Press the i key to enter the edit mode.
e) Add the following code:

<? xml
version =" 1 . 0 " encoding =" UTF - 8 "? >
< Server
port =" 8006 " shutdown =" SHUTDOWN ">
< Listener
className =" org . apache . catalina . core .
JreMemoryL eakPrevent ionListene r "/>
< Listener
className =" org . apache . catalina . mbeans .
GlobalReso urcesLifec ycleListen er "/>
< Listener
className =" org . apache . catalina . core .
ThreadLoca lLeakPreve ntionListe ner "/>
< Listener
className =" org . apache . catalina . core .
AprLifecyc leListener "/>
< GlobalNami ngResource s >
< Resource
name =" UserDataba se " auth =" Container "
type =" org . apache . catalina . UserDataba se "
descriptio n =" User
database
that
can
be
updated
and
saved "
Issue: 20190919

45

Elastic Compute Service

Tutorials / 3 Conﬁgure Java Web

factory =" org . apache . catalina . users . MemoryUser
DatabaseFa ctory "
pathname =" conf / tomcat - users . xml "/>
</ GlobalNami ngResource s >
< Service
name =" Catalina ">
< Connector
port =" 8080 "
protocol =" HTTP / 1 . 1 "
connection Timeout =" 20000 "
redirectPo rt =" 8443 "
maxThreads =" 1000 "
minSpareTh reads =" 20 "
acceptCoun t =" 1000 "
maxHttpHea derSize =" 65536 "
debug =" 0 "
disableUpl oadTimeout =" true "
useBodyEnc odingForUR I =" true "
enableLook ups =" false "
URIEncodin g =" UTF - 8 "/>
< Engine
name =" Catalina " defaultHos t =" localhost ">
< Realm
className =" org . apache . catalina . realm .
LockOutRea lm ">
< Realm
className =" org . apache . catalina . realm .
UserDataba seRealm "
resourceNa me =" UserDataba se "/>
</ Realm >
< Host
name =" localhost " appBase ="/ data / wwwroot / default
" unpackWARs =" true " autoDeploy =" true ">
< Context
path ="" docBase ="/ data / wwwroot / default "
debug =" 0 " reloadable =" false " crossConte xt =" true "/>
< Valve
className =" org . apache . catalina . valves .
AccessLogV alve " directory =" logs "
prefix =" localhost_ access_log ." suffix =". txt " pattern
="% h % l % u % t & quot ;% r & quot ; % s % b " />
</ Host >
</ Engine >
</ Service >
</ Server >
f ) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.

3. Set Java virtual machine (JVM) memory parameters.
a) Run the command vi

/ usr / local / tomcat / bin / setenv . sh to

create a ﬁle named / usr / local / tomcat / bin / setenv . sh .

b) Press the i key to enter the edit mode.
c) Add the following code:

JAVA_OPTS ='- Djava . security . egd = file :/ dev /./ urandom
server - Xms256m - Xmx496m - Dfile . encoding = UTF - 8 '

-

d) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.
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4. Set a script to enable Tomcat to run at startup.
a) Run the command wget

https :// github . com / lj2007331 /

oneinstack / raw / master / init . d / Tomcat - init to download

the script.

b) Run the command mv

Tomcat - init

rename the Tomcat - init ﬁle.

c) Run the command chmod

+ x

/ etc / init . d / tomcat to

/ etc / init . d / tomcat to assign the

execute permission to the script ﬁle.

d) Run the following code to set the JAVA_HOME script for automatic startup.
sed - i ' s @^ export
JAVA_HOME =.*@ export
JAVA_HOME =/
usr / java / jdk1 . 8 . 0_191 @' / etc / init . d / tomcat
5. Set automatic startup.
chkconfig
chkconfig

-- add
tomcat

tomcat
on

6. Start Tomcat.
service

tomcat

start

Step 7: Deploy a Java application to the ECS instance

You can use Cloud Toolkit to deploy a Java application to the ECS instance. Then, you
connect to http :// Public
8080 to view Tomcat
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1. In Eclipse, right-click the name of the application project that you want to deploy,
and choose Alibaba Cloud > Deploy to ECS....

2. In the window Deploy to Alibaba Cloud that appears, follow these settings:

• Deploy File: the deployment method, such as Upload File in this example. If you
build the application project by using Maven, select Maven Build.

• Choose File: the ﬁle that you want to deploy.

• Target Deploy ECS: speciﬁes the region where your instance is located and the
target instance.

• Deploy Location: the directory that you deploy on the ECS instance, such as /
data / wwwroot / default in this example.

• Command: Click Select..., and in the dialog box that appears, click Add.... Enter
a command in the text box. The ECS instance runs the command automatically
after the Cloud Toolkit plug-in deploys the Java application to the directory on
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the ECS instance. In this example, enter the service

tomcat

restart

command to restart Tomcat. You can also enter another command as needed.

3. Click Deploy to start deploying the Java application to the ECS instance.
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4. In the Console section of Eclipse, you can view the progress of the deployment.

5. Open your browser, and in the address bar, enter the URL http :// Public
IP

address

instance.

of

the

ECS

instance : 8080 to connect to the ECS

The following response indicates that the Java application has been deployed to the
ECS instance by using the Alibaba Cloud Toolkit for Eclipse plug-in.

What's next

You can modify the Java application in Eclipse, save the code, and then use the Cloud
Toolkit plug-in again to deploy the modiﬁed ﬁle to the ECS instance.
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4 Deploy a Node.js project on CentOS

This topic describes how to install Node.js and deploy a project on an ECS instance
that runs CentOS 7.2.

Prerequisites

• You have installed PuTTY on the computer that you use for connecting to the ECS
instance. You can click here to download PuTTY.

• You must have an Alibaba Cloud account before you follow the instructions

provided in the tutorial. To create an Alibaba Cloud account, click Create an
Alibaba Cloud account.

Context

Node.js is a JavaScript runtime built on Chrome V8 engine. You can use Node.js to

eﬃciently build an online application that supports easy extension. Node.js uses an
event-driven and non-blocking I/O model. This lightweight and eﬃcient model is

suitable for data-intensive real-time applications that run on distributed devices. The
Node.js package manager (npm) is the largest ecosystem of open source libraries in
the world. Node.js is applicable to the following typical scenarios:

• Real-time applications: instant messaging and real-time notiﬁcations, such as
Socket.IO.

• Distributed applications: eﬃcient parallel I/O to consume existing data.

• Utilities: a variety of utilities from front-end compression and deployment

applications such as grunt to desktop graphical user interface applications.

• Game applications: real-time and high-concurrency applications in the game ﬁeld,
such as the Pomelo framework of NetEase.

• Stable functions to improve the performance of rendering Web pages.

• Consistent front-end and back-end programming environments: applications that
allow front-end developers to easily take on server-side development, such as

the full-stack Javascript MongoDB, Express.js, AngularJS, and Node.js. (MEAN)
framework.

Procedure

To install Node.js on an ECS instance and deploy a project, follow these steps:
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1. Step 1: Create and connect to an ECS instance
2. Step 2: Deploy the Node.js environment
3. Step 3: Deploy a test project

Step 1: Create and connect to an ECS instance

To create and connect to an ECS instance, follow these steps:

1. Use the public image 64-bit CentOS 7.2 to create an ECS instance. For more
information, see Create an ECS instance.

2. Use the root user to connect to the ECS instance. For more information, see
#unique_12.

Step 2: Deploy the Node.js environment

Deploy the Node.js environment in any of the following ways:
• Use a binary ﬁle to install the Node.js environment

The installation package used in the deployment is a compiled binary ﬁle. After

you decompress the package, the node and npm ﬁles already exist in the bin folder
, so you do not need to recompile the binary ﬁle.

To deploy the Node.js environment by using the binary ﬁle, follow these steps:
1. Download the Node.js installation package.

wget
https :// nodejs . org / dist / v6 . 9 . 5 / node - v6 . 9
. 5 - linux - x64 . tar . xz
2. Decompress the ﬁle.
tar

xvf

node - v6 . 9 . 5 - linux - x64 . tar . xz

3. After you create a soft link, you can run node and npm commands directly in
any directory.
ln
usr
ln
usr

/
/

s / root /
local / bin
s / root /
local / bin

node - v6 . 9 . 5 - linux - x64 / bin / node /
/ node
node - v6 . 9 . 5 - linux - x64 / bin / npm /
/ npm

4. Check the versions of node and npm.
node
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- v

Then, the Node.js environment has been installed. By default, the software is
installed in the directory / root / node - v6 . 9 . 5 - linux - x64 /.

5. To install the software in another directory such as / opt / node /, run the
following commands in sequence:
mkdir
mv /
rm rm ln ln -

- p
root
f /
f /
s /
s /

/ opt / node /
/ node - v6 . 9 . 5 - linux - x64 /* / opt / node /
usr / local / bin / node
usr / local / bin / npm
opt / node / bin / node / usr / local / bin / node
opt / node / bin / npm / usr / local / bin / npm

• Use NVM to install multiple versions

Node Version Manager (NVM) is the software used to manage Node.js versions.

You can use NVM to easily switch Node.js versions. NVM is suitable for developers
that are dedicated to Node.js or that need to eﬃciently update or switch Node.js

versions.

To install multiple Node.js versions by using NVM, follow these steps:

1. Use Git to clone source code to the local directory ~/. nvm , and check the latest
update.
yum
git
&&
= 0

install
git
clone
https :// github . com / cnpm / nvm . git ~/. nvm
cd ~/. nvm && git
checkout ` git
describe -- abbrev
-- tags `

2. Activate NVM.
echo ". ~/. nvm / nvm . sh " >> / etc / profile
source / etc / profile
3. Retrieve a list of all Node.js versions.
nvm

list - remote

4. Install multiple Node.js versions.
nvm
nvm

install
install

5. Run the nvm

v6 . 9 . 5
v7 . 4 . 0

ls command to check the version of the installed Node.js

environment. Node.js v7.4.0 is installed in this example. The response is as
follows:

[ root @ iZXXXXZ . nvm ]#
v6 . 9 . 5
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->

v7 . 4 . 0
system
stable -> 7 . 4 (-> v7 . 4 . 0 ) ( default )
unstable -> 6 . 9 (-> v6 . 9 . 5 ) ( default )

6. Run the command nvm
response is as follows:

use

v7 . 4 . 0 to switch to Node.js v7.4.0. The

[ root @ iZXXXXZ . nvm ]# nvm
Now
using
node
v7 . 4 . 0

use

v7 . 4 . 0

Step 3: Deploy a test project

To deploy a test project, follow these steps:
1. Create the example . js project ﬁle.
cd ~
touch

example . js

2. Use the vim editor to open the example . js project ﬁle.
yum
vim

install
vim
example . js

Press the i key to enter the edit mode, and copy the following code to the project
ﬁle. Afterward, press the Esc key to exit the edit mode. Type : wq and press the
Enter key to save and close the ﬁle.

The code that you copy to the project ﬁle is as follows:
const
const
const
const
res
res
res
});

http = require (' http ');
hostname = ' 0 . 0 . 0 . 0 ';
port = 3000 ;
server = http . createServ er (( req , res ) => {
. statusCode = 200 ;
. setHeader (' Content - Type ', ' text / plain ');
. end (' Hello
World \ n ');

server . listen ( port , hostname , () => {
console . log (` Server
running
at
http ://${ hostname }:
${ port }/`);
});
Note:

In this example, you specify Port 3000 as the service port. You can also specify
another port in your actual running environment. However, you must add an

inbound rule to the security group of the ECS instance to support the speciﬁed
port.
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3. Run the project.
node

~/ example . js

&

4. Run the following command to check whether the deployed application is listening
on the speciﬁed port.
netstat

- tpln

In this example, the response contains Port 3000, indicating that the application is
listening on the port.

5. Log on to the ECS console, and add an inbound rule to the security group of the ECS
instance to support the speciﬁed port, such as Port 3000 in this example.

For more information about how to add security group rules, see #unique_20.

6. Open your local browser, and in the address bar, enter the URL http ://<
Public

IP

address

access the project.

of

the

ECS

instance >: Port

number to

More information

Alibaba Cloud sandbox platform
Alibaba Cloud Marketplace
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5 Build a Magento website on ECS

Magento is an open-source e-commerce platform written in PHP. Many customers use
it to build their B2B or B2C e-commerce platforms. This tutorial explains how to build
a Magento platform on a single ECS insgtance.

In this tutorial,we will install the following tools:
• MySQL version: 5.7
• PHP version: 7.0

• Magento version: 2.2

Prerequisites

Create an ECS instance. Make sure the instance meets the following requirements:

Operating system: CentOS 7.2 64bit. Minimum speciﬁcations include 2 Core CPU, 4
GiB RAM, and a 40 GiB Ultra Cloud Disk as the system disk. VPC-connected. If you

do not have a VPC network, one will be created when you create an ECS instance. A
public IP address is assigned to the instance.

Inbound Internet traﬃc to the TCP Port 80 of the ECS instance is allowed. For more
information, see create an ECS instance and add a security group rule.
Service

HTTP
MySQL

Rule

Authorizat Protocol

Port

Direction ion

Type

Inbound

Userdeﬁned

80/80

Userdeﬁned

3306/
3306

Inbound

Policy
Allow
Allow

TCP
TCP

Range

Authorizat Authorizat Priority
ion Type

ion

Address
Field

0.0.0.0/0

1

0.0.0.0/0

1

Access

Address
Field

Object

Access

Procedure

To build a Magento website using ECS, follow these steps:
Step 1: Install LAMP on ECS.

Step 2: Conﬁgure the database.

Step 3: Install and conﬁgure Composer.
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Step 4: Install and conﬁgure Magento.
Step 5: Test the installation.

Step 1: Install LAMP (Linux, Apache, MySQL, and PHP) on ECS

This section describes how to manually install the LAMP platform. You can also start
the ECS instance directly from the cloud market by purchasing LAMP images so that
you can quickly build a website.

1. Connect to the ECS instance and install Apache and MySQL.
# yum - y
update
# yum - y
install
httpd
# rpm - Uvh
http :// dev . mysql . com / get / mysql57 community - release - el7 - 8 . noarch . rpm
# yum - y
install
mysql - community - server
2. Start Apache and MySQL service and enable them at startup.
#
#
#
#

systemctl
systemctl
systemctl
systemctl

start
enable
start
enable

httpd
httpd
mysqld
mysqld

3. Conﬁgure the Apache conﬁguration ﬁle: /etc/httpd/conf/httpd.conf.
a. Run vim

/ etc / httpd / conf / httpd . conf .

b. Press the i key.

c. Add the LoadModule

rewrite_mo

so line below Include
AllowOverr

section.
#
#

Options

ide

Indexes

dule

modules / mod_rewrit

e .

conf . modules . d /*. conf , and replace

None with AllowOverr
FollowSymL

ide

all in the following

inks

AllowOverr ide
controls
what
directives
may
be
placed
in . htaccess
files .
# It
can
be " All ", " None ", or
any
combinatio n
of
the
keywords :
# Options
FileInfo
AuthConfig
Limit
#
AllowOverr ide
None
d. Press the Esc key and type : wq to save and exit the ﬁle.

4. Obtain the temporary password of the root account at the installation of MySQL by
running the following.
#

grep
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2016 - 12 - 13T14 : 57 : 47 . 535748Z
1 [ Note ] A
password
is
generated
for
root @ localhost :
lsHD

temporary
p0 / G28g >

5. Finish the MySQL security conﬁguration, including:
• Resetting the root account password
• Disabling remote root logon

• Removing anonymous users

• Removing test database and test database access

For more information, see the oﬃcial documentation.

# mysql_secu re_install ation
Securing
the
MySQL
server
deployment .
Enter
password
for
user
root : # Enter
your
temporary
root
password
that
is
recorded
in
the
previous
step
The ' validate_p assword ' plugin
is
installed
on
the
server .
The
subsequent
steps
will
run
with
the
existing
configurat ion
of
the
plugin .
Using
existing
password
for
root .
Estimated
strength
of
the
password : 100
Change
the
password
for
root ? ( Press
y | Y
for
Yes
, any
other
key
for
No ): Y
New
password : # Enter
a
new
strong
password . The
password
can
be [ 8 , 30 ] characters
in
length . It
must
contain
uppercase
letters , lowercase
letters , and
numbers . The
following
special
characters
are
allowed
: ()`~! @#$%^& amp ;*-+=|{}[]:;‘& lt ;>,.? /
Re - enter
new
password : # Repeat
the
new
password
to
confirm
it
Estimated
strength
of
the
password : 100
Do
you
wish
to
continue
with
the
password
provided
?( Press
y | Y
for
Yes , any
other
key
for
No ) :
Y
By
default , a
MySQL
installati on
has
an
anonymous
user , allowing
anyone
to
log
into
MySQL
without
having
to
have
a
user
account
created
for
them
. This
is
intended
only
for
testing , and
to
make
the
installati on
go
a
bit
smoother . You
should
remove
them
before
moving
into
a
production
environmen t .
Remove
anonymous
users ? ( Press
y | Y
for
Yes , any
other
key
for
No ): Y
Success .
Normally , root
should
only
be
allowed
to
connect
from ' localhost '.
This
ensures
that
someone
cannot
guess
at
the
root
password
from
the
network .
Disallow
root
login
remotely ? ( Press
y | Y
for
Yes ,
any
other
key
for
No ): Y
Success .
By
default , MySQL
comes
with
a
database
named ' test
' that
anyone
can
access .
This
is
also
intended
only
for
testing , and
should
be
removed
before
moving
into
a
production
environmen t .
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Remove
test
database
and
access
to
it ? ( Press
y | Y
for
Yes , any
other
key
for
No ): Y
- Dropping
test
database ...
Success .
- Removing
privileges
on
test
database ...
Success .
Reloading
the
privilege
tables
will
ensure
that
all
changes
made
so
far
will
take
effect
immediatel y .
Reload
privilege
tables
now ? ( Press
y | Y
for
Yes ,
any
other
key
for
No ): Y
Success .
All
done !
6. Install PHP 7.
# yum
install - y
http :// dl . iuscommuni ty . org / pub /
ius / stable / CentOS / 7 / x86_64 / ius - release - 1 . 0 - 14 .
ius . centos7 . noarch . rpm
# yum - y
update
# yum - y
install
php70u
php70u - pdo
php70u - mysqlnd
php70u - opcache
php70u - xml
php70u - gd
php70u - mcrypt
php70u - devel
php70u - intl
php70u - mbstring
php70u bcmath
php70u - json
php70u - iconv
7. Validate PHP installation.
# php - v
PHP
7 . 0 . 13 ( cli ) ( built : Nov
10
2016
08 : 44 : 18
) ( NTS )
Copyright ( c ) 1997 - 2016
The
PHP
Group
Zend
Engine
v3 . 0 . 0 , Copyright ( c ) 1998 - 2016
Zend
Technologi es
with
Zend
OPcache
v7 . 0 . 13 , Copyright ( c ) 1999 2016 , by
Zend
Technologi es
8. Edit the /etc/php.ini ﬁle to set your time zone:
a. Run vim

/ etc / php . ini .

b. Press the i key.

c. Find the line starting with date . timezone which is commented out by

default, and add the correct time zone. If your site is in China, add date .
timezone

=

Asia / Shanghai .

9. Restart httpd by running the following.
systemctl

start

httpd

Step 2: Conﬁgure the database

Follow these steps to conﬁgure a database:
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1. Create a database and a user. Run the following commands, including those typed
in the mysql> prompt.

# mysql - u
root - p
Enter
password :
mysql > CREATE
DATABASE
magento ;
Query
OK , 1
row
affected ( 0 . 00
sec )
mysql > GRANT
ALL
ON
magento . * TO
YourUser @ localhost
IDENTIFIED
BY ' YourPass ';
Query
OK , 0
rows
affected , 1
warning ( 0 . 00
sec )
mysql > FLUSH
PRIVILEGES ;
Query
OK , 0
rows
affected ( 0 . 00
sec )
2. Run exit to exit MySQL.
3. Test the new user.

# mysql - u
YourUser - p
mysql > show
databases ;
+--------------------+
| Database |
+--------------------+
| informatio n_schema |
| magento |
+--------------------+
2
rows
in
set ( 0 . 00
mysql > exit

sec )

Step 3: Install and conﬁgure Composer
1. Install Composer.

# curl - sS
https :// getcompose r . org / installer | php
All
settings
correct
for
using
Composer
Downloadin g
1 . 2 . 4 ...
Composer
successful ly
installed
to : / root / composer .
phar
Use
it : php
composer . phar
2. Conﬁgure Composer.
#

mv

/ root / composer . phar

/ usr / bin / composer

3. Test Composer.
# composer - v
______
/ ____ / ___
____
___
____
____
________
_____
/ / / __ \/ __ ` __ \/ __ \/ __ \/ ___ / _ \/ ___ /
/ / ___ / / _ / / / / / / / / _ / / / _ / ( __ ) __ / /
\ ____ /\ ____ / _ / / _ / / _ / . ___ /\ ____ / ____ /\ ___ / _ /
/ _ /
Composer
version
1 . 2 . 4
2016 - 12 - 06
22 : 00 : 51
Step 4: Install and conﬁgure Magento
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1. Download Magento from github using the following commands through git
clone .

#
#
#

yum - y
install
git
cd / var / www / html /
git
clone
https :// github . com / magento / magento2 . git

2. Switch the version of Magento to the stable production version.
# cd
magento2 && git
. 0
Switched
to
a
new

checkout
branch

tags / 2 . 1 . 0

- b

2 . 1

' 2 . 1 . 0 '

3. Move the installation ﬁles to the Apache root directory. If you skip this step, you

will only be able to access your Magento service at http :// your - server ip

/ magento2 .

# shopt - s
dotglob
nullglob && mv / var / www / html /
magento2 /* / var / www / html / && cd ..
4. Set Magento ﬁle permissions.
# chown
# find
chmod
# find
chmod
# chmod
# chmod
# chmod

- R : apache / var / www
/ var / www / html - type
640
/ var / www / html - type
750
- R
g + w / var / www /
- R
g + w / var / www /
750 / var / www / html /

5. Run composer
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/ html
f - print0
d

- print0

|

xargs

- r0

|

xargs

- r0

html /{ pub , var }
html /{ app / etc , vendor }
bin / magento

install to install Magento.
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6. Use your browser to access your server at http :// public
of

62

your

ECS

IP

address

instance . You will see a welcome screen like this one.
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7. Click Agree and Setup Magento and ﬁll in the database information, web

conﬁguration, and accounts as follows. When you get a page like this, the
installation is successful.

Step 5: Conﬁgure the cron job
1. Run crontab

- u

apache

- e .

2. Add the following in the /etc/crontab ﬁle.
*/ 10 * * * *
cron : run
*/ 10 * * * *
. php
*/ 10 * * * *
setup : cron

php

- c

/ etc

/ var / www / html / bin / magento

php

- c

/ etc

/ var / www / html / update / cron

php - c
: run

/ etc

/ var / www / html / bin / magento

For more information, see the oﬃcial documentation.
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What to do next

Visit http :// public

IP

address

of

your

ECS

instance to see

Visit http :// public

IP

address

of

your

ECS

instance / admin

the default home page.

, and use the user name and password you set during the installation to log on to the

Dashboard.

For more information about Magento conﬁguration, see the oﬃcial documentation.
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6 Build Microsoft SharePoint 2016 on an ECS
instance

This topic describes how to build Microsoft SharePoint 2016 on an ECS instance.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

Microsoft SharePoint Portal Server (Microsoft SharePoint) is a portal developmen
t environment that allows enterprises to develop intelligent portals. Microsoft

SharePoint can be seamlessly integrated with knowledge bases and individual
users and teams can easily connect to the environment. Microsoft SharePoint

empowers your business by means of eﬃcient information processing. Microsoft
SharePoint provides an enterprise-wide service solution. Based on the feature of

integrating enterprise applications, you can ﬂexibly choose deployment options and
management tools to integrate information from various systems into this solution.

The procedure described in this topic is applicable to users that are familiar with ECS
instances and Windows Server operating systems.
The following software versions are used:

• Operating system: Windows Server 2012 R2 DataCenter
• Database: SQL Server 2014 SP1

The ECS instances described in this topic use the following conﬁgurations:
• CPU: 4 vCPUs

• Memory: 8 GB

Procedure

To build Microsoft SharePoint 2016 on an ECS instance, follow these steps:
1. Step 1: Add the AD, DHCP, DNS, and IIS services
2. Step 2: Install SQL Server 2014

3. Step 3: Install SharePoint 2016
Issue: 20190919
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Step 1: Add the AD, DHCP, DNS, and IIS services

To add the Active Directory (AD), Dynamic Host Conﬁguration Protocol (DHCP),

Domain Name System (DNS), and Internet Information Services (IIS) services, follow
these steps:

1. Purchase an ECS instance. For more information, see #unique_23.
2. Disable Internet Explorer Enhanced Security Conﬁguration.
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3. Add roles and features of DNS, DHCP, IIS, and .NET Framework3.5.
a) Click Add roles and features.

b) Add the AD, DHCP, and DNS services. Select Active Directory Domain Services,
DHCP Server, and DNS Server, and click Next.

c) Add the IIS service. Select Web Server IIS, and click Next.
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d) In the Features section, select .NET Framework 3.5 Features.

e) Click Next until the end of installation.
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4. Conﬁgure the AD service. Click Add a new forest, and enter a domain name in the
Root domain name ﬁeld to create a domain environment.

5. Set the password, and click Next until the end of the conﬁguration.
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6. Click Complete DHCP conﬁguration to set the DHCP feature.

a) Check the DHCP conﬁguration description, and click Next.

b) Keep the default conﬁguration, and click Commit to complete the installation.

Step 2: Install SQL Server 2014

To install the SQL Server 2014 database, follow these steps:
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1. Install SQL Server 2014 SP1, go to the SQL Server Installation Center window, and
click the ﬁrst installation option.

2. Enter the product key, and click Next.

3. Accept the license terms, and click Next.

4. Complete the installation check, and click Next.
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5. Keep the default option, and click Next.

6. Click Select All to select all features, and click Next.
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7. Conﬁgure the SQL Server instance: Click Default instance to use the default
instance ID.
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8. Specify the account names and passwords for SQL Server Database Engine and SQL
Server Analysis Services.
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9. Click Add Current User to add the current user, and click Next.

10.Click Add Current User to add the current user again, and click Next.
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11.Click Next until the end of the installation.

Step 3: Install SharePoint 2016

To install SharePoint 2016, follow these steps:

1. Install the SharePoint 2016 prerequisite installer: Open the image folder, and
double-click the executable ﬁle of the prerequisite installer.

2. In the installation wizard, click Next.

3. Accept the license terms, and install necessary components.

4. Open the Setup . exe ﬁle, enter the product key in the dialog box that appears,
accept the license terms, and then click Continue.

5. Specify the installation directory, or keep the default setting as shown in this
example, and then click Install Now.

6. At the end of the installation, select Run the SharePoint Products Conﬁguration
Wizard now and close the wizard.

Step 4: Conﬁgure SharePoint 2016

To conﬁgure SharePoint 2016, follow these steps:
1. Select Create a new server farm.
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2. Specify conﬁguration database settings and the database access account. The

database is installed on the local host. Therefore, you must specify the local IP
address as the database server.

3. Specify the server role.

4. Select Specify port number, and enter 10000 in the ﬁeld. You can also specify
another port number as needed.

5. Check the conﬁgurations and click Next.

Now, you can open the SharePoint Central Administration Web application.
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7 Build Docker on a CentOS 7-based ECS instance
This topic describes how to deploy Docker on CentOS.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

The procedure described in this topic is applicable to developers that are familiar
with Linux, but new to Alibaba Cloud ECS instances.

Procedure

To build Docker on a CentOS 7-based ECS instance, follow these steps:
1. Deploy Docker
2. Use Docker

3. Create an image

Deploy Docker

You can purchase a required image from Alibaba Cloud Marketplace, and easily
deploy Docker. You can also install Docker manually as described in this topic.
In the following example, the operating system version is CentOS
3 . 10 . 0 - 514 . 6 . 2 . el7 . x86_64 .

7 . 2

64

Note:

Docker requires a 64-bit Linux system with Kernel 3.10 or later.

To deploy Docker, follow these steps:

1. Add a Yellowdog Updater, Modiﬁed (YUM) repository.
#
#
#

yum
yum
yum

install
epel - release
clean
all
list

– y

2. Install and run Docker.
#
78

yum

install

docker - io

– y
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3. Check the installation result.
#

docker

info

The following response indicates that Docker has been installed.

Use Docker

You can use Docker in these ways:
1. Manage the Docker daemon.
#
#

systemctl
systemctl
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start
stop

docker
docker

# Runs
# Stops

the
the

Docker
Docker

daemon .
daemon .
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# Restarts

the

Docker

2. Manage images. The following example uses Apache images from Alibaba Cloud
image repository.

# docker
pull
registry . cn - hangzhou . aliyuncs . com /
lxepoo / apache - php5
• Modify the tag of an image from Alibaba Cloud image repository to memorize
the image easily.
#

docker
tag
registry . cn - hangzhou . aliyuncs . com /
lxepoo / apache - php5 : latest
aliweb : v1

• Check existing images.
#

docker

images

• Delete an image.
#

docker
rmi – f
registry . cn - hangzhou . aliyuncs . com /
lxepoo / apache - php5

3. Manage containers.

• Enter a container. Run the docker

images command to obtain the image

ID e1xxxxxxxxxe. Afterward, run the docker
container corresponding the image ID.
#

docker

run

– ti

e1xxxxxxxx

xe

run command to enter the

/ bin / bash

• Exit the container. Run the exit command to exit the container.
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• You can combine the run command with the – d parameter to run the

container in the background. The -- name parameter speciﬁes apache as the
container name.
#

docker

run

- d

-- name

apache

e1xxxxxxxx

xe

• Enter the container that runs in the background.
#

docker

exec

- ti

apache

/ bin / bash

• Create an image from the container.
#

docker
me : tag

commit

containerI

D / containerN

ame

newImageNa

• To easily test and restore an image, you can run the source image, create a new

image with a simple name from the source image, and then test the new image.
#

docker

commit

4c8066cd8c

01

apachephp : v1

• Run the container and map Port 8080 of the host with the container.
#

docker

run

- d

- p

8080 : 80

apachephp : v1

In a browser, enter the IP address of the host followed by Port 8080 to connect
to the container. The following response indicates that the container runs

normally.

Create an image

To create an image, follow these steps:
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1. Prepare the following content in a Dockerﬁle.

# vim
Dockerfile
FROM
apachephp : v1
# Declares
a
base
image .
MAINTAINER
DTSTACK # Declares
the
image
owner .
RUN
mkdir / dtstact # The
commands
that
you
want
to
run
before
the
container
starts . You
must
add
these
commands
to
the
end
of
the
RUN
command
. The
Dockerfile
can
only
contain
127
lines
or
less . Therefore , we
recommend
that
you
write
the
required
commands
that
you
have
not
written
in
the
Dockerfile
to
a
script
if
the
Dockerfile
cannot
contain
these
commands .
ENTRYPOINT
ping
www . aliyun . com # The
commands
that
run
at
startup . The
last
command
must
be
a
front
- end
command
that
runs
constantly . Otherwise , the
container
will
exit
after
running
all
commands .
2. Build an image.
docker
build - t
webcentos : v1 .
# The
single
dot
(.) specifies
the
path
of
the
Dockerfile
and
must
be
provided .
docker
images
# Checks
whether
the
image
has
been
created .
docker
run – d
webcentos : v1
# Runs
the
container
in
the
background .
docker
ps
# Queries
the
container
in
operation .
docker
ps – a
# Queries
all
containers
including
those
in
the
stopped
state .
docker
logs
CONTAINER
ID / IMAGE
# Checks
the
startup
log
to
troublesho ot
the
issue
based
on
the
container
ID
or
name
if
the
started
container
does
not
exist
in
the
query
result .
docker
commit
fb2844b6c0 70
dtstackweb : v1 # The
container
ID
and
the
name
and
version
of
the
new
image . You
must
add
the
informatio n
to
the
end
of
the
commit
command .
docker
images
# Queries
images
that
have
been
downloaded
and
created
on
the
premises .
docker
push
# Pushes
an
image
to
the
default
remote
image
repository , Docker
Hub .
3. Push the image to the registry.

Enter your own ImageId and image

version .

docker
login -- username = dtstack_pl us
registry . cn shanghai . aliyuncs . com # Specifies
the
password
of
the
image
repository . You
enter
the
informatio n
after
you
run
this
command .
docker
tag [ ImageId ] registry . cn - shanghai . aliyuncs .
com / dtstack123 / test :[ Image
version ]
docker
push
registry . cn - shanghai . aliyuncs . com /
dtstack123 / test :[ Image
version ]
The image has been pushed to the registry if you can view the image version in the
image repository.
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8 Deploy LAMP on ECS

This topic describes how to build a LAMP stack on an ECS instance. LAMP is an

acronym of the names of its four open-source components: the Linux operating

system, Apache HTTP Server, MySQL relational database management system, and
PHP programming language.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

This example uses an ECS instance with the following conﬁguration:
• Uses the 64-bit CentOS 7.2 operating system
• Uses a VPC network

• Uses the public IP address of the ECS instance

This example chooses the following software versions. When you build a LAMP stack,
choose software versions as needed.
• Apache 2.4.37
• MySQL 5.6.24
• PHP 7.0.32

• phpMyAdmin 4.0.10.20

This topic is intended for individual users who are familiar with the Linux operating
system, but new to using Alibaba Cloud ECS to build websites.

This topic describes how to manually build a LAMP stack. You can also purchase a
LAMP image on Alibaba Cloud Marketplace and start the ECS instance to quickly
build a website.

Procedure

Follow these steps to build a LAMP stack on an ECS instance:
1. Step 1. Prepare the compilation environment
2. Step 2. Install Apache HTTP Server
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3. Step 3. Install the MySQL database management system
4. Step 4. Install PHP

5. Step 5. Install phpMyAdmin

Step 1. Prepare the compilation environment

Follow these steps to prepare the compilation environment:
1. #unique_26.
2. #unique_17.

3. Run the cat

/ etc / redhat - release command to view the system version.

4. Disable the ﬁrewall.

a) Run the systemctl
status.

status

firewalld command to check the ﬁrewall

• If the ﬁrewall status is inactive , the ﬁrewall is disabled.

• If the ﬁrewall status is active , the ﬁrewall is enabled. In this example, the
ﬁrewall is enabled. Therefore, you must disable the ﬁrewall.

b) The ﬁrewall must be disabled. If the ﬁrewall has already been disabled, skip this
step.

• If you want to temporarily disable the ﬁrewall, run the systemctl
firewalld command.

stop

Note:

This command temporarily disables the ﬁrewall. After you restart the Linux
operating system, the ﬁrewall is enabled.

• If you want to permanently disable the ﬁrewall, run the systemctl
disable

firewalld command.

Note:
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You can enable the ﬁrewall again. For more information, see the ﬁrewall site.

5. Disable SELinux.

a) Run the getenforce command to check the SELinux status.

• If the SELinux status is Disabled , SELinux is disabled.

• If the SELinux status is Enforcing , SELinux is enabled. In this example,
SELinux is enabled. Therefore, you must disable SELinux.

b) Disable SELinux. If SELinux has already been disabled, skip this step.
• If you want to temporarily disable SELinux, run the setenforce
command.

0

Note:

This command temporarily disables SELinux. After you restart the Linux
operating system, SELinux is enabled.

• If you want to permanently disable SELinux, run the vi

/ etc / selinux

/ config command to edit the conﬁguration ﬁle of SELinux. Press Enter

to run the command, move the cursor to the SELINUX = enforcing row,
and press I to edit the conﬁguration ﬁle. Change SELINUX=enforcing to

SELINUX = disabled , press Esc , enter : wq , and then press Enter to

save and close the conﬁguration ﬁle.
Note:

You can enable SELinux again. For more information, see the SELinux
documentation.

c) Restart the system to apply the settings.

6. Add an inbound rule to the security group of the ECS instance to open the required
port. For more information, see #unique_10.

Step 2. Install Apache HTTP Server

Follow these steps to install Apache HTTP Server.
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1. Run the following commands to install the dependency package:
a.

b.
c.

yum

groupinsta

yum

install

yum
install
devel - y

ll

" Developmen

libtool

t

Tools " - y

- y

expat - devel

pcre

pcre - devel

openssl -

2. Run the following commands to download and decompress the Apache, APR, and
APR-util source code packages:
a.

wget
https :// mirrors . aliyun . com / apache / httpd / httpd
- 2 . 4 . 37 . tar . gz

b.

wget
https :// mirrors . aliyun . com / apache / apr / apr - 1
. 6 . 5 . tar . gz

c.

wget
https :// mirrors . aliyun . com / apache / apr / apr util - 1 . 6 . 1 . tar . gz

d.

tar
src

xvf

httpd - 2 . 4 . 37 . tar . gz

tar

xvf

apr - 1 . 6 . 5 . tar . gz

e.
f.

tar
xvf
/ src

- C

- C

/ usr / local /

/ usr / local / src

apr - util - 1 . 6 . 1 . tar . gz

- C

/ usr / local

Note:

The source code version is continuously upgraded. You can obtain the installation

package path in the httpd source code installation package or the APR source code
installation package.

3. Run the following commands to move the APR and APR-until folders to the Apache
srclib folder:

a.

b.
c.

cd
mv

/ usr / local / src
apr - 1 . 6 . 5

httpd - 2 . 4 . 37 / srclib / apr

mv
apr - util - 1 . 6 . 1
util

httpd - 2 . 4 . 37 / srclib / apr -

4. Run the following commands to compile the source code:
a.

cd

/ usr / local / src / httpd - 2 . 4 . 37

b. ./ buildconf
c.
86

./ configure -- prefix =/ usr / local / apache2
-- enable - ssl \
-- enable - so \

\
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with with enable
enable
enable
enable

make

&&

mpm = event \
included - apr \
- cgi \
- rewrite \
- mods - shared = most
- mpms - shared = all
make

\

install

5. Run the following commands to set the PATH environment variable:
a.

b.

echo " export
PATH =$ PATH :/ usr / local / apache2 / bin "
> / etc / profile . d / httpd . sh
source

/ etc / profile . d / httpd . sh

6. You can run the httpd

- v command to view the Apache version number.

7. Add the Apache conﬁguration ﬁle.
a) Run the vi

/ usr / lib / systemd / system / httpd . service

command to open the conﬁguration ﬁle.

b) Press I and add the following content to the conﬁguration ﬁle:
[ Unit ]
Descriptio n = The
Apache
After = network . target

HTTP

Server

[ Service ]
Type = forking
ExecStart =/ usr / local / apache2 / bin / apachectl

- k

start

ExecReload =/ usr / local / apache2 / bin / apachectl - k
graceful
ExecStop =/ usr / local / apache2 / bin / apachectl - k
graceful - stop
PIDFile =/ usr / local / apache2 / logs / httpd . pid
PrivateTmp = false
[ Install ]
WantedBy = multi - user . target
c) Press Esc , enter : wq , and then press Enter to save and close the Apache
conﬁguration ﬁle.
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8. Run the following commands to start Apache HTTP Server and enable Apache
HTTP Server to automatically start when the operating system is started.
a.

b.

systemctl

start

systemctl

enable

httpd
httpd

9. Check the installation status.
a) Log on to the ECS console.

b) In the left-side navigation pane, choose Instances & Images > Instances.

c) On the Instances page, ﬁnd the target instance and copy its public IP address.
d) Enter http ://

The

public

IP

address

of

the

ECS

instance into the address bar of your browser, and then press Enter .

If the following page is displayed, it indicates that Apache HTTP Server has been
started.

Step 3. Install the MySQL database management system

Follow these steps to install the MySQL database management system:
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1. Run the following commands to prepare the compiling environment:
a.

yum

install

ncurses - devel

b.

yum

install

cmake

a.

cd

bison

gnutls - devel

- y

- y

2. Run the following commands to prepare a directory to store MySQL data.
b.

mkdir

c.

/ mnt / data

groupadd

d.

useradd

e.

id

- r
- r

mysql
- g

mysql

- s

/ sbin / nologin

mysql

mysql

3. Run the following command to change the owner and group of the data directory.
chown

- R

mysql : mysql

/ mnt / data

4. Run the following commands to download, decompress, and compile the GA
version of the source code:
a.

wget
https :// downloads . mysql . com / archives / get / file
/ mysql - 5 . 6 . 24 . tar . gz

b.

tar
src

c.

d.

cd
-

xvf

mysql - 5 . 6 . 24 . tar . gz

- C

/ usr / local /

/ usr / local / src / mysql - 5 . 6 . 24

cmake . - DCMAKE_INS TALL_PREFI X =/ usr / local / mysql \
DMYSQL_DAT ADIR =/ mnt / data \
DSYSCONFDI R =/ etc \
DWITH_INNO BASE_STORA GE_ENGINE = 1 \
DWITH_ARCH IVE_STORAG E_ENGINE = 1 \
DWITH_BLAC KHOLE_STOR AGE_ENGINE = 1 \
DWITH_READ LINE = 1 \
DWITH_SSL = system \
DWITH_ZLIB = system \
DWITH_LIBW RAP = 0 \
DMYSQL_TCP _PORT = 3306 \
DDEFAULT_C HARSET = utf8 \
DMYSQL_UNI X_ADDR =/ usr / local / mysql / mysql . sock \
DDEFAULT_C OLLATION = utf8_gener al_ci \
DWITH_SYST EMD = 1 \
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- DINSTALL_S
e.

make

&&

YSTEMD_UNI

make

TDIR =/ usr / lib / systemd / system

install

5. Run the following command to change the group of the installation directory to
mysql:

chown

- R

mysql : mysql

/ usr / local / mysql /

6. Run the following commands to initialize the database and copy the conﬁguration
ﬁle:
a.

cd

/ usr / local / mysql

b. / usr / local / mysql / scripts / mysql_inst
mysql -- datadir =/ mnt / data /
c.

d.

mv

/ etc / my . cnf

all_db

-- user =

/ etc / my . cnf . bak

cp / usr / local / mysql / support - files / my - default . cnf
/ etc / my . cnf

7. Run the following command to change the installation and data storage paths:
echo - e " basedir = / usr / local / mysql \ ndatadir
data \ n " >> / etc / my . cnf

= / mnt /

8. Modify the MySQL conﬁguration ﬁle.
a) Run the vi

/ usr / lib / systemd / system / mysql . service

command to open the MySQL conﬁguration ﬁle.

b) Press I and enter the following content:
[ Unit ]
Descriptio n = MySQL
Community
After = network . target
After = syslog . target

Server

[ Install ]
WantedBy = multi - user . target
Alias = mysql . service
[ Service ]
User = mysql
Group = mysql
Permission sStartOnly = true
ExecStart =/ usr / local / mysql / bin / mysqld
TimeoutSec = 600
Restart = always
PrivateTmp = false
c) Press Esc , enter : wq , and then press Enter to save and close the MySQL
conﬁguration ﬁle.
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9. Run the following commands to set the PATH environment variable:
a.

b.

echo " export
PATH =$ PATH :/ usr / local / mysql / bin " > /
etc / profile . d / mysql . sh
source

/ etc / profile . d / mysql . sh

10.Run the following commands to start MySQL and enable it to automatically start
when the operating system is started:
a.

b.

systemctl

start

systemctl

enable

mysql
mysql

11.Change the MySQL root password. Run the following command and set the
password by following the instructions:
mysqladmin

- u

root

password

12.Run the following command to log on to the MySQL database:
mysql

- uroot

- p

13.Run the \ q command to log out of MySQL.

Step 4. Install PHP

Follow these steps to install PHP:
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1. Run the following command to install the dependency package:
yum
install
libmcrypt
libmcrypt - devel
mhash
mhash devel
libxml2
libxml2 - devel
bzip2
bzip2 - devel - y
2. Run the following commands to download, decompress, and compile the GA
version of the source code package:
a.

b.
c.

d.
e.
f.

g.

cd
wget
http :// cn2 . php . net / get / php - 7 . 0 . 32 . tar .
bz2 / from / this / mirror
cp

mirror

tar
src
cd
./
-----------------

xvf

php - 7 . 0 . 32 . tar . bz2
php - 7 . 0 . 32 . tar . bz2

- C

/ usr / local /

/ usr / local / src / php - 7 . 0 . 32

configure -- prefix =/ usr / local / php \
with - config - file - scan - dir =/ etc / php . d \
with - apxs2 =/ usr / local / apache2 / bin / apxs \
with - config - file - path =/ etc \
with - pdo - mysql = mysqlnd \
with - mysqli =/ usr / local / mysql / bin / mysql_conf
enable - mbstring \
with - freetype - dir \
with - jpeg - dir \
with - png - dir \
with - zlib \
with - libxml - dir =/ usr \
with - openssl \
enable - xml \
enable - sockets \
enable - fpm \
with - bz2

make

&&

make

ig

\

install

Note:

If the ECS instance does not have suﬃcient memory space, terminate PHP

extensions that you do not need when you conﬁgure PHP to save memory space.
For example, you can add -- disable - fileinfo to the ./ configure
command to terminate the ﬁleinfo extension.
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3. Run the following command to copy the PHP conﬁguration ﬁle:
cp

php . ini - production

4. Run the vi

/ etc / php . ini

/ usr / local / apache2 / conf / httpd . conf command

to open the Apache conﬁguration ﬁle, and then press I to edit the conﬁguration
ﬁle.

a) Find the ServerName parameter and add ServerName
the parameter.

localhost : 80 to

b) Find the Directory parameter. Add a number sign (#) before Require
denied , start a new line, and then add Require

c) Find DirectoryI
ndex

ndex

index . php

all

granted .

all

index . html and replace it with DirectoryI

index . html .

d) Find the following content:
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Add the following content:
AddType
AddType

applicatio
applicatio

n / x - httpd - php . php
n / x - httpd - php - source

. phps

After you add the content, the conﬁguration is as follows.

e) Press Esc , enter : wq , and then press Enter to save and close the Apache
conﬁguration ﬁle.

5. Add Apache support for PHP parsing.

a) Run the following command to open the index . php ﬁle:
vi

/ usr / local / apache2 / htdocs / index . php

b) Press I to edit the ﬁle. Add the following content to the ﬁle:
<? php
phpinfo ();
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? >
c) Press Esc to exit the edit mode. Enter : wq to save and close the index .
php ﬁle.

d) Run the following command to restart Apache HTTP Server.
systemctl
6. Enter http ://

restart
The

httpd

public

IP

address

of

the

ECS

instance into the address bar of your browser and press Enter .

If the following page is displayed, it indicates that PHP parsing is working properly.

Step 5. Install phpMyAdmin

Follow these steps to install phpMyAdmin:
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1. Run the following commands to prepare a directory to store phpMyAdmin data:
a.

b.

cd
mkdir

- p

/ usr / local / apache2 / htdocs / phpmyadmin

2. Run the following command to download and decompress the phpMyAdmin
package:
a.

b.

wget
https :// files . phpmyadmin . net / phpMyAdmin / 4 . 0 .
10 . 20 / phpMyAdmin - 4 . 0 . 10 . 20 - all - languages . zip
unzip

phpMyAdmin - 4 . 0 . 10 . 20 - all - languages . zip

3. Run the following command to copy the phpMyAdmin ﬁle to the prepared storage
directory:

mv
phpMyAdmin - 4 . 0 . 10 . 20 - all - languages /*
local / apache2 / htdocs / phpmyadmin
4. Enter http ://

The

public

IP

address

of

the

/ usr /
ECS

instance / phpmyadmin into the address bar of your browser, and press Enter
to go to the logon page of phpMyAdmin.

If the following page is displayed, it indicates that phpMyAdmin has been installed.
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5. Enter the MySQL username and password, and click Go.
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9 Deploy databases based on ECS
9.1 Use MySQL on ECS

MySQL is a relational database management system. It provides tools to build Web

applications, such as applications based on the Linux, Apache, MySQL, PHP (LAMP)
or Linux, NGINX, MySQL, PHP (LNMP) stack. This topic describes how to install,
conﬁgure, and remotely access the MySQL database on an ECS instance.

Related conﬁguration

This topic is based on the following software:

• Operating system: public image for CentOS 7.2 64-bit
• MySQL: 5.7.26

This topic is based on an Elastic Compute Service (ECS) instance with the following
speciﬁcation:

• CPU: 2 vCPUs

• Memory: 4 GiB

• Network type: VPC

• IP address: public IP address

Prerequisites

You have added inbound rules to the security group associated with the ECS instance.
Port 3306 is open for inbound traﬃc. For more information, see Add security group
rules.

Procedure

1. Prepare the environment.
2. Install MySQL.

3. Conﬁgure MySQL.

4. Remotely access MySQL.

Step 1: Prepare the environment

1. Log on to the ECS instance. For more information, see Connect to a Linux instance
by using an SSH key pair or Connect to a Linux instance by using a password.

Issue: 20190919

99

Elastic Compute Service

Tutorials / 9 Deploy databases based on ECS

Step 2: Install MySQL

1. Run the following command to update the YUM repository.
rpm - Uvh
http :// dev . mysql . com / get / mysql57 community - release - el7 - 9 . noarch . rpm
2. Run the following command to install MySQL.
yum

- y

install

mysql - community - server

3. Run the following command to view the version of MySQL.
mysql

- V

MySQL is successfully installed if the following is returned.
mysql
Ver
14 . 14
Distrib
5 . 7 . 26 ,
x86_64 ) using
EditLine
wrapper

for

Linux

(

Step 3: Conﬁgure MySQL

1. Run the following command to launch MySQL.
systemctl

start

mysqld

2. Run the following command to enable MySQL to run at boot time.
systemctl

enable

mysqld

3. Run the following command to view the /var/log/mysqld.log ﬁle and record the
temporary password of the root user.

# grep ' temporary
password ' / var / log / mysqld . log
2019 - 04 - 28T06 : 50 : 56 . 674085Z
1 [ Note ] A
temporary
password
is
generated
for
root @ localhost : 3w ) WqGlM7
- o ,
Note:

You need the temporary password when you reset the password for the root user.

4. Run the following command to conﬁgure the security settings of MySQL.
mysql_secu

re_install

ation

The security settings of MySQL involve the following steps.
a. Reset the password for the root user.
Enter
password
password
for
obtained .
100

for
the

user
root

root : # Enter
the
temporary
user
that
you
previously
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The ' validate_p assword ' plugin
is
installed
on
the
server .
The
subsequent
steps
will
run
with
the
existing
configurat ion
of
the
plugin .
Using
existing
password
for
root .
Estimated
strength
of
the
password : 100
Change
the
password
for
root ? ( Press
y | Y
for
Yes , any
other
key
for
No ) : Y
New
password : # Enter
a
new
password , that
is
8
to
30
characters
in
length . It
must
contain
uppercase
and
lowercase
letters , digits , and
special
characters . The
following
special
characters
are
allowed : ( ) ` ~ ! @ # $ % ^ & * - + = | { } [ ] : ; ' <
> , . ? /
Re - enter
new
password : # Re - enter
the
new
password
for
confirmati on .
Estimated
strength
of
the
password : 100
Do
you
wish
to
continue
with
the
provided
password ?( Press
y | Y
for
Yes , any
other
key
for
No ) : Y
b. Enter Y to disable the anonymous user account.
By
default , a
MySQL
installati on
has
an
anonymous
user , allowing
anyone
to
log
into
MySQL
without
having
to
have
a
user
account
created
for
them
. This
is
intended
only
for
testing , and
to
make
the
installati on
go
a
bit
smoother . You
should
remove
them
before
moving
into
a
production
environmen t .
Remove
anonymous
users ? ( Press
y | Y
for
Yes , any
other
key
for
No ): Y
Success .
c. Enter Y to deny remote access by the root user.
Disallow
root
, any
other
Success .

login
remotely ? ( Press
key
for
No ): Y

y | Y

for

Yes

d. Enter Y to remove the test database and access permissions to this database.
Remove
test
database
and
access
Y
for
Yes , any
other
key
for
- Dropping
test
database ...
Success .

to
it ? ( Press
No ): Y

y |

e. Enter Y to reload privilege tables.
Reload
privilege
tables
, any
other
key
for
Success .
All
done !

now ? ( Press
No ): Y

y | Y

for

Yes

For more information about security settings of MySQL, see MySQL Documentation
.
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Step 4: Remotely access the MySQL database

You can use a database client or Data Management Service (DMS) provided by Alibaba
Cloud to remotely access the MySQL database. In this topic, we take DMS as an

example to describe how to remotely access the MySQL database.

1. On the ECS instance, create an account for remote access to MySQL.

a. Run the following command and enter the password for the root user to log on
to MySQL.
mysql

- uroot

- p

b. Run the following commands in the order described here to create an account

for remote logon to MySQL. In this example, we use dms as the account name
and 123456 as the password.

mysql > grant
all
on *.* to ' dms '@'%' IDENTIFIED
BY
' 123456 '; # Replace
dms
with
root
to
enable
remote
logon
with
the
root
account .
mysql > flush
privileges ;
Note:

• We recommend that you use a non-root account to remotely log on to the
MySQL database instead of using the root account.

• When you create an account, you need to replace the password 123456

with a password that meets the security strength requirements. It must be
8 to 30 characters in length and contain uppercase and lowercase letters,

digits, and special characters. The following special characters are allowed:
( ) ` ~ ! @ # $ % ^ & * - + = | { } [ ] : ; ' < > , . ? /.

2. Log on to the Data Management Service console.

3. In the left-side navigation pane, select User-created databases (ECS, Internet).
4. Click Add Database.

5. Conﬁgure the database that you have created. For more information, see Conﬁgure
user-created databases.

6. Click Log On.

After logging on, you can use the menu bar of DMS to create databases, tables,
functions, and other objects. For more information, see Manage user-created
databases that are hosted on ECS.
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10 Install SharePoint 2016

This topic describes how to install SharePoint 2016.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

To install SharePoint 2016, you must meet the following environment requirements:
• Basic conﬁgurations:

- Windows Server 2012

- CPU: 4 vCPUs. Memory: 8 GB. You can design the architecture and purchase ECS
instances according to actual environments.

• Software environment:

- SQL Server 2012 Express
- SharePoint 2016

- Active Directory (AD)

- Domain Name System (DNS)

- Internet Information Services (IIS)

• Required component: .NET Framework 3.5 for installing SQL Server.
Note:

- When you install .Net Framework 3.5, an error may occur at the step of adding
roles and features. For more information about how to ﬁx this issue, see What

can I do if I am unable to install .NET Framework 3.5.1, or a language package,
on Windows Server 2012 R2/2016/2019?.

- For more information about the required component of SharePoint, see
Microsoft documentation. The system indicates that you need to install

dependencies when you install SharePoint. If you fail to install dependencies,
Procedure

you cannot install SharePoint.
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1. Build AD.
Note:

Modify the Security Identiﬁer (SID) before you add a client to a domain. In this

topic, only one ECS instance is used to install SharePoint. Therefore, all roles and

features are assigned to the instance. In your actual running environment, do not
install SQL, AD, and SharePoint servers on the same instance.

2. Install SQL Server 2012 Express.

Use the default method to install SQL Server. In this topic, the Express edition is
used in the test environment. Follow these rules:
Note:

• The Express edition has the TCP/IP protocol disabled by default. You must
manually enable the protocol.

• The Express edition may have no console. You must install a SQL management
tool.

• We recommend that you use the SQL Server Enterprise edition that provides
more features than the Express edition.

3. Install SharePoint 2016.

a) Install the required components of SharePoint.
Note:

To use the installation wizard, your instance must be authorized to access
the Internet. If your instance is not authorized, you have to download the
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components and run commands to install these components. For more
information, see Microsoft documentation.

b) Restart the ECS instance, and install Sharepoint.

c) Run the SharePoint 2016 installation wizard, enter the product key, and then
click Continue.

Start to install SharePoint 2016.

d) Run the SharePoint conﬁguration wizard.

e) Click Create a new server farm, and click Next.

f ) Specify conﬁguration database settings and the database access account.
g) Specify the server role.

h) Specify the port number for the SharePoint Central Administration Web
application and conﬁgure security settings.

i) Complete the conﬁguration wizard and start to install SharePoint.
j) Click Finish.

What's next

After you install SharePoint, you can conﬁgure the server farm in the SharePoint

Central Administration Web application. When you conﬁgure the server farm, only
enable the required services. Otherwise, unnecessary memory pressure may be
incurred.
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11 Build a primary/secondary PostgreSQL system
based on ECS

PostgreSQL is regarded as the most advanced open source database. ApsaraDB RDS
for PostgreSQL is compatible with NoSQL databases, supports eﬃcient queries and

plug-in management, and provides secure and stable services. This topic describes
how to build a primary/secondary PostgreSQL system based on ECS.

Prerequisites

• You must have an Alibaba Cloud account before you follow the instructions

provided in the tutorial. To create an Alibaba Cloud account, click Create an
Alibaba Cloud account.

• You have added an inbound rule to the security group of the ECS instance to
support Port 5432. For more information, see #unique_20.

Context

The procedure described in this topic is applicable to Alibaba Cloud users that

are familiar with Alibaba Cloud ECS instances, the Linux operating system, and
PostgreSQL databases.

The following software versions are used in this topic. The versions may be diﬀerent
in your actual running environment.
• Operating system: CentOS 7.2
• PostgreSQL: version 9.5.6

You can install PostgreSQL on an ECS instance in either of the following ways:

• Image deployment: Go to the Alibaba Cloud Marketplace page, and search for the
required PostgreSQL image for installation.

• Manual deployment: Install PostgreSQL by using source code or Yellowdog Update
, Modiﬁed (YUM).

Procedure

To install PostgreSQL by using YUM and build the primary/secondary architecture of
PostgreSQL, follow these steps:

1. Step 1: Activate two ECS instances
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2. Step 2: Conﬁgure the primary node of PostgreSQL

3. Step 3: Conﬁgure the secondary node of PostgreSQL

4. Step 4: Test the primary/secondary architecture of PostgreSQL

Step 1: Activate two ECS instances

To build the primary/secondary architecture of PostgreSQL, you must activate two

ECS instances that run in a Virtual Private Cloud (VPC). One ECS instance works as
a primary node and the other ECS instance works as a secondary node. For more
information, see #unique_23.
Note:

We recommend that you do not assign public IP addresses to the ECS instances.

Instead, you can attach an Elastic IP Address (EIP) to each ECS instance. This allows
you to upgrade the conﬁgurations or optimize the architecture in the follow-up
management. For more information, see #unique_32.

Step 2: Conﬁgure the primary node of PostgreSQL

To conﬁgure the primary node of PostgreSQL, follow these steps:

1. On the primary ECS instance, run the following commands in sequence to install
PostgreSQL.
a.

b.
c.

yum

update

- y

yum
install
https :// download . postgresql . org / pub
/ repos / yum / 9 . 5 / redhat / rhel - 7 - x86_64 / pgdg centos95 - 9 . 5 - 3 . noarch . rpm - y
yum
install
contrib - y

postgresql

95 - server

d. / usr / pgsql - 9 . 5 / bin / postgresql

postgresql
95 - setup

95 initdb

Note:

The package pgdg - centos95 - 9 . 5 - 3 . noarch . rpm is used in this
topic. In your actual running environment, use the latest RPM package.
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2. Run the following commands in sequence to start the PostgreSQL service and
enable PostgreSQL to run at startup.
a.

systemctl
start
the
PostgreSQL

b.

systemctl
PostgreSQL

postgresql - 9 . 5 . service
service .

enable
postgresql - 9 . 5 . service
to
run
at
startup .

# Starts
# Enables

3. Create a database account named replica that is used for replication between the

primary and secondary nodes. Afterward, specify the password, logon permission,
and backup permission.

a) Run the following command to log on to PostgreSQL.
su

-

postgres

b) Type psql in the following command to enter the PostgreSQL interactive
terminal.

- bash - 4 . 2 $

psql

c) Enter the following SQL statement to create the database account named

replica, and specify the password, logon permission, and backup permission.
postgres =# CREATE
encrypted
password

ROLE
replica
' replica ';

login

replicatio

n

d) Check whether the database account named replica is created.
postgres =#

SELECT

usename

from

pg_user ;

The following response indicates that the account named replica has been
created.

usename
---------postgres
replica
( 2
rows )
e) Check whether the permissions are created.
postgres =#

SELECT

rolname

from

pg_roles ;

The following response indicates that the permissions have been created.
rolname
---------postgres
replica
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rows )

f ) Type \ q in the command, and press the Enter key to exit the PostgreSQL
interactive terminal.
postgres =# \ q
g) Type exit in the command, and press the Enter key to exit PostgreSQL.
- bash - 4 . 2 $
logout

exit

4. Run the following command to open the ﬁle pg_hba . conf , and set a whitelist
for replica.
vim

/ var / lib / pgsql / 9 . 5 / data / pg_hba . conf

Add the following lines to the IPv4

local

connection

s ﬁeld.

host
all
all
192 . 168 . 1 . 0 / 24
md5
#
Enables
MD5
password
encryption
for
connection s
in
the
CIDR
block
of
the
VPC .
host
replicatio n
replica
192 . 168 . 1 . 0 / 24
md5
#
Enables
data
synchroniz ation
from
the
replicatio n
database .
5. Run the following command to open the postgresql . conf ﬁle.
vim

/ var / lib / pgsql / 9 . 5 / data / postgresql . conf

Set the following parameters:
wal_level = hot_standb y
# Enables
the
hot
standby
mode .
synchronou s_commit = on
# Enables
synchroniz ation .
max_wal_se nders = 32
# The
maximum
number
of
synchroniz ation
processes .
wal_sender _timeout = 60s # The
timeout
value
for
the
streaming
replicatio n
instance
to
synchroniz e
data .
max_connec tions = 100
# The
maximum
number
of
connection s . The
value
of
max_connec tions
for
the
secondary
node
must
be
larger
than
that
for
the
primary
node .
6. Run the following command to restart the PostgreSQL service.
systemctl

restart

postgresql - 9 . 5 . service

Step 3: Conﬁgure the secondary node of PostgreSQL

To conﬁgure the secondary node of PostgreSQL, follow these steps:
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1. Run the following commands in sequence to install PostgreSQL.
a.

b.
c.

yum

update

- y

yum
install
https :// download . postgresql . org / pub
/ repos / yum / 9 . 5 / redhat / rhel - 7 - x86_64 / pgdg centos95 - 9 . 5 - 2 . noarch . rpm - y
yum
install
contrib - y

postgresql

95 - server

postgresql

95 -

2. Run the following command and use the pg_basebackup utility to create a backup
directory.

# pg_basebac kup - D / var / lib / pgsql / 9 . 5 / data - h <
Primary
node
IP > - p
5432 - U
replica - X
stream - P
Password :
30075 / 30075
kB ( 100 %), 1 / 1
tablespace
3. Run the following commands in sequence to create and open the recovery .
conf ﬁle.

a.

b.

cp / usr / pgsql - 9 . 5 / share / recovery . conf . sample
var / lib / pgsql / 9 . 5 / data / recovery . conf
vim

/

/ var / lib / pgsql / 9 . 5 / data / recovery . conf

Set the following parameters:
standby_mo de = on
# Declares
the
secondary
node .
primary_co nninfo = ' host =< Primary
node
IP > port = 5432
user = replica
password = replica ' # Connection
informatio
n
of
the
primary
node .
recovery_t arget_time line = ' latest ' # Synchroniz es
the
latest
data
by
using
streaming
replicatio n .
4. Run the following command to open the postgresql . conf ﬁle.
vim

/ var / lib / pgsql / 9 . 5 / data / postgresql . conf

Set the following parameters:
max_connec tions = 1000
# The
maximum
number
of
connection s . The
value
for
the
secondary
node
must
be
larger
than
that
for
the
primary
node .
hot_standb y = on
# Enables
the
hot
standby
mode .
max_standb y_streamin g_delay = 30s
# The
maximum
delay
for
streaming
replicatio n .
wal_receiv er_status_ interval = 1s
# The
maximum
interval
for
the
secondary
node
to
report
the
running
status
to
the
primary
node .
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= on
report

errors

#

Enables
the
during
replicatio

n .

5. Run the following command to modify the group and owner of the data directory.
chown
data

- R

postgres . postgres

/ var / lib / pgsql / 9 . 5 /

6. Run the following commands in sequence to start the PostgreSQL service and
enable PostgreSQL to run at startup.
a.

systemctl
start
the
PostgreSQL

b.

systemctl
PostgreSQL

postgresql - 9 . 5 . service
service .

# Starts

enable
postgresql - 9 . 5 . service
to
run
at
startup .

# Enables

Step 4: Test the primary/secondary architecture of PostgreSQL

To test the primary/secondary architecture of PostgreSQL, follow these steps:

1. Run the following command to check the sender process on the primary node.
ps

aux

| grep

sender

The following response indicates that the sender process is available.
postgres
2916
0 . 0
0 . 3
340388
3220
15 : 38
0 : 00
postgres : wal
sender
replica
192 . 168 . 1 . 222 ( 49640 ) streaming

?

Ss
process
0 / F01C1A8

2. Run the following command to check the receiver process on the secondary node.
ps

aux

| grep

receiver

The following response indicates that the receiver process is available.
postgres
23284
0 . 0
0 . 3
16 : 04
0 : 00
postgres :
streaming
0 / F01C1A8

387100
3444
wal
receiver

?

process

Ss

3. On the primary node, run the following SQL statement to check the status of the
secondary node.
replicatio

n =#

select

*

from

pg_stat_re

plication ;

The following response indicates that the status of the secondary node is available.
pid | usesysid | usename | applicatio n_name | client_add
r | client_hos tname | client_por t | backend_st art |
backend_xm in | state | sent_locat ion | write_loca ti
on | flush_loca tion | replay_loc ation | sync_prior ity
| sync_state
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------+----------+---------+------------------+--------------+-----------------+------------- +------------------------------+--------------+-----------+---------------+---------------+----------------+-----------------+---------------+-----------2916 | 16393 | replica | walreceive r | 192 . 168 . 1 .
222 | | 49640 | 2017 - 05 - 02
15 : 38 : 06 . 188988 + 08 |
1836 | streaming | 0 / F01C0C8 | 0 / F01C0C8
| 0 / F01C0C8 | 0 / F01C0C8 | 0 | async
( 1
rows )
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12 Deploy the Ghost blogging platform on CentOS
7

Ghost is a free open source blogging platform developed on the basis of Node.js. The
platform is used to simplify the online publishing process for individual blogs and

online publications. This topic describes how to deploy the Ghost blogging platform.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

As your business scope is increasingly enlarged, you can use comprehensive services
of Alibaba Cloud to scale up and scale out your business capacity. For example, you
can optimize your business in the following ways:

• Scale up the vCPU and memory of a single ECS instance to enhance the processing
performance.

• Add multiple ECS instances and implement load balancing among these instances.
• Use Auto Scaling to automatically increase or decrease the number of ECS
instances based on business requirements.

• Use Object Storage Service (OSS) to store a large amount of data such as static web
pages, images, and videos.

This topic describes how to deploy the Ghost blogging platform on an ECS instance

that has basic conﬁgurations. The procedure described in this topic is applicable to
individual users that are new to website construction with ECS instances.

Procedure

To deploy the Ghost blogging platform on an ECS instance, follow these steps:
1. Step 1: Create a Linux-based ECS instance
2. Step 2: Deploy the Web environment
3. Step 3: Install Ghost

4. Step 4: Purchase a domain

5. Step 5: Apply for an ICP ﬁling
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6. Step 6: Resolve the domain name to the IP address of the instance

Step 1: Create a Linux-based ECS instance

To build an individual website, you need only one ECS instance.

This section describes how to create an ECS instance. If you have a custom image, you
can create an instance from this image. For more information, see #unique_34.
Create a Linux-based ECS instance. For more information, see #unique_23.
To set parameters, follow these rules:

• Instance Type: For an individual website, you can use an instance of 1 vCPU and 2

GiB or 2 vCPUs and 4 GiB to meet basic requirements. For more information about
instance types, see #unique_35.

• Network Type: Click VPC in the Network Type section.

• Network Billing Method: To enable the ECS instance to connect to the Internet, you
must conﬁgure an Elastic IP address (EIP) and attach the EIP to the ECS instance.
If you do not select Assign Public IP Address, the ECS instance has no public IP
address conﬁgured. The actual conﬁgurations depend on your requirements.

• Image: To build a website, you can click Public Image, and select a Linux operating
system such as CentOS from the drop-down list.

After you create an instance, the system sends you an SMS message and an email to

notify you of the information about the instance, such as the instance name, public

IP address, and internal IP address. You can use the information to log on to the ECS
console and manage the instance.

The system notiﬁes you of most important information by sending SMS messages. To
authenticate some important operations such as restarting or stopping the instance

, you must use your mobile phone to receive veriﬁcation codes. Therefore, after you

bind a mobile number to your Alibaba Cloud account, you must keep the correspond
ing mobile phone in the normal running status.

Step 2: Deploy the Web environment

This section describes how to deploy the Web environment by installing NGINX.
The software package provides NGINX 1.10.2.
Note:
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This version is used in the following example. The version that you download may be
diﬀerent in your actual running environment.

Prerequisites:

• Your instance can connect to the Internet.

• You have installed a tool for connecting to the Linux-based ECS instance.
SecureCRT is used as the tool in this section.

To deploy the Web environment, follow these steps:

1. Open the SecureCRT client and specify the information of the instance that you
want to log on to.

a) Specify the name of the session for connecting to the ECS instance.
b) Select SSH from the Protocol drop-down list.

c) Enter the host IP address in the Hostname ﬁeld and specify the username.
d) Click Connect.
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2. Enter the root username and the password.

3. Add the NGINX repository.
[ root @ localhost ~]# rpm - Uvh
http :// nginx . org / packages
/ centos / 7 / noarch / RPMS / nginx - release - centos - 7 - 0 .
el7 . ngx . noarch . rpm
4. Install NGINX.
[ root @ localhost

~]# yum

- y

install

nginx

5. Enable NGINX to run at startup.
[ root @ localhost

~]#

systemctl

enable

nginx . service

6. Start NGINX and check the NGINX service status.
[ root @ localhost
[ root @ localhost

~]# systemctl
~]# systemctl

start
status

nginx . service
nginx . service

7. Open your browser, and in the address bar, enter the public IP address of the ECS
instance to view the default NGINX web page.

Then, the NGINX environment is ready to run.

Step 3: Install Ghost

To install Ghost, follow these steps:
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1. Run the following command to update system software to the latest versions.
[ root @ localhost

~]#

yum

- y

update

2. Install Node.js.

a) Install Extra Packages for Enterprise Linux (EPEL).
[ root @ localhost

~]#

yum

install

epel - release

~]#

yum

install

nodejs

- y

b) Install Node.js and npm.
[ root @ localhost
enablerepo = epel

npm

--

c) Install the process manager to control Node.js applications. This process
manager keeps the applications in the running state.
[ root @ localhost

~]#

d) Run the commands node

3. Install Ghost.

npm

install

- v and npm

pm2

- g

- v to check the Node.js version.

a) Create the Ghost installation directory.
[ root @ localhost

~]#

mkdir

- p

/ var / www / ghost

b) Enter the Ghost installation directory, and run the following command to
download the latest Ghost version.

[ root @ localhost ~]# cd / var / www / ghost
[ root @ localhost
ghost ]# curl - L
https :// ghost . org /
zip / ghost - latest . zip - o
ghost . zip
c) Decompress the Ghost package.
[ root @ localhost
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ghost ]#

unzip

ghost ]#

npm

ghost . zip

d) Use npm to install Ghost.
[ root @ localhost
e) Run the npm

been installed.

install

- production

start command to start Ghost and check whether Ghost has

f ) Create a copy of the example conﬁguration ﬁle config . example . js , and
rename the ﬁle as config . js .
[ root @ localhost
. js

ghost ]#

cp

config . example . js

config

g) In the config . js ﬁle, specify the domain of the Ghost blogging platform as
the URL .

[ root @ localhost

ghost ]#

vim

config . js

h) Use the process manager to enable Ghost to run permanently.
[ root @ localhost
ghost ]# NODE_ENV = production
index . js -- name " ghost "

pm2

start

i) Start, stop, and then restart Ghost.
[ root @ localhost
[ root @ localhost
118
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stop

ghost
ghost
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ghost ]#

pm2

restart

ghost

4. Install NGINX.

a) Add the NGINX repository.
[ root @ localhost ~]# rpm - Uvh
http :// nginx . org /
packages / centos / 7 / noarch / RPMS / nginx - release - centos
- 7 - 0 . el7 . ngx . noarch . rpm
b) Install NGINX.
[ root @ localhost

~]#

yum

- y

install

nginx

c) Enable NGINX to run at startup.
[ root @ localhost

~]#

systemctl

enable

nginx . service

d) Start NGINX and check the NGINX service status.
[ root @ localhost
[ root @ localhost

~]# systemctl
~]# systemctl

start
status

nginx . service
nginx . service

e) Open your browser, and in the address bar, enter the public IP address of the
ECS instance to view the default NGINX web page.
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5. Specify NGINX as the reverse proxy for Ghost.

a) Enter the NGINX conﬁguration directory, and create the NGINX conﬁguration
ﬁle for Ghost.

[ root @ localhost
conf

~]# vim

/ etc / nginx / conf . d / ghost .

b) Add the following content to the ghost . conf ﬁle, and set server_nam

e

to the domain that is used in your actual running environment.

c) Change the name of the default conﬁguration ﬁle default . conf to

default . conf . bak , so NGINX is only applicable to ghost . conf .

[ root @ localhost

~]# mv

default . conf

default . conf . bak

d) Restart the NGINX service.
[ root @ localhost
service

conf . d ]#

systemctl

restart

nginx .

6. Connect to the Ghost blogging platform.

a) Open your browser, and in the address bar, enter the URL http :// IP
address
Ghost
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Note:

If the system returns Error Code 502, check whether you have disabled the
ﬁrewall.

b) To edit your Ghost blogging platform, open your browser, and in the address
bar, enter the URL http :// IP
ghost .

address

of

the

ECS

instance /

Step 4: Purchase a domain

You can specify a unique domain for your website. Therefore, users can visit your
website by using a simple domain instead of a complex IP address.
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We recommend that you visit www.net.cn to purchase a domain.

1. Go to the Domains page, enter the domain that you want to use in the search bar,

and then click Find A Domain. If the searched domain has not been registered, you
can purchase the domain. Specify the domain that you want to purchase and the
service duration for the domain, and click Buy Now.

2. When you conﬁrm the order, you must specify the owner of the domain.

To simplify the operation, we recommend that you select Person temporarily. You
can change the owner in the follow-up management. In this example, a personal
domain is speciﬁed.

3. If you purchase the domain for the ﬁrst time, you must create the registrant proﬁle.
For more information, see Create the registrant proﬁle.

4. Enter the authentic registrant proﬁle.

5. To pass the real-name veriﬁcation, upload the scanned image of your identity card.
The proﬁle veriﬁcation takes one to ﬁve working days.

Step 5: Apply for an ICP ﬁling

You must apply for an IPC ﬁling for the domain that is associated with a website

hosted on a server in Mainland China. Your website cannot provide services until you
obtain the ICP license number for the domain.

The Alibaba Cloud ICP Filing system can help you simplify the ICP ﬁling procedure.
You can apply for an ICP ﬁling free of charge. The review duration is approximately
20 days.

1. Log on to the ICP Filing Management console.

2. In the left-side navigation pane, choose ICP Filing Management > ICP No.

Application, and click Apply to apply for the service identiﬁcation number for

the ECS instance that you have purchased. You will use the service identiﬁcation
number when you register an ICP ﬁling.

3. In the dialog box that appears, click OK.

4. After the system issues the service identiﬁcation number, the ICP No. Management
tab appears and displays the service identiﬁcation number that is associated

with the ECS instance. For more information about ICP ﬁling, click the Filing
Introduction tab.
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5. If you apply for an ICP ﬁling for the ﬁrst time, you must register an IPC ﬁling
account in the Alibaba Cloud ICP Filing system .
Note:

The IPC ﬁling account is used only for ICP ﬁling and diﬀerent from an Alibaba
Cloud account.

Step 6: Resolve the domain name to the IP address of the instance

You must resolve the domain name to the IP address of the ECS instance, so users can
visit your website by using the domain name. Follow these steps:
1. Log on to the Domain console.

2. In the left-side navigation pane, choose Domain > Domain Names. Find the domain

name that you want to resolve, and in the Actions column next to the domain name,
click Resolve.

3. Click Getting Started.

4. Enter the public IP address of your Linux-based instance in the dialog box that
appears, and click Submit.

Then, you can use the domain name to visit your website.

Issue: 20190919

123

Elastic Compute Service

Tutorials / 13 Build a Drupal-based website on CentOS 7

13 Build a Drupal-based website on CentOS 7

This topic describes how to build a Drupal-based website on an ECS instance that
runs CentOS 7.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

Drupal is a free and open source content management framework (CMF) written in
Hypertext Preprocessor (PHP). Drupal consists of a content management system
(CMS) and a PHP development framework. You can use Drupal to build dynamic

websites that provide various features and services, and to support website projects
in diﬀerent applications from personal blogs to large communities.

The procedure described in this topic is applicable to users that are familiar with

Alibaba Cloud ECS instances and Linux, but new to website construction with ECS
instances.

Procedure

To build a Drupal-based website on an ECS instance, follow these steps:
1. Step 1: Activate an ECS instance

2. Step 2: Build the Web environment
3. Step 3: Install Drupal

Step 1: Activate an ECS instance

You can activate an ECS instance to build a personal website. In the follow-up

management, you can upgrade the instance or optimize the architecture as needed.

Step 2: Build the Web environment

You can build the Web environment on the ECS instance in any of the following ways:
• Image deployment

• Easy deployment with an installation package
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• Manual deployment: Build the environment by using source code or Yellowdog
Update, Modiﬁed (YUM).

We recommend that you use an image. This is an easy way to build the Web

environment for the ﬁrst time. If you have some basic knowledge of Linux operations
and maintenance, you can use an installation package, the source code, or the YUM
utility to customize the Web environment. This topic describes how to build the

Drupal website by using an image.

1. When you create an ECS instance, in the Image section, choose Marketplace Image

> Select from image market including operating system. For more information, see
Create an ECS instance.

2. Type LAMP in the search bar, click Search, and then select the ﬁrst matched image
in this example.

3. Click Continue.

You can also go to Alibaba Cloud Marketplace, and search for and purchase the
required images.

In this topic, the software versions used in the environment include: CentOS
. 2
1

|

Apache

2 . 4 . 25

| Drupal8 . 1 . 1 .

|

MySQL

5 . 7 . 17

|

PHP

7

7 . 1 .

Note:

The versions that you download may be diﬀerent in your actual running
environment.

Step 3: Install Drupal

To install Drupal, follow these steps:

1. Download the Drupal installation package.
# wget
http :// ftp . drupal . org / files / projects / drupal 8 . 1 . 1 . zip
2. Decompress the package to your website root directory.
#
#

unzip
drupal - 8 . 1 . 1 . zip
mv
drupal - 8 . 1 . 1 /* / var / www / html /

3. Download the Chinese translation package.
#

cd
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# wget - P
profiles / standard / translatio ns
http :// ftp .
drupal . org / files / translatio ns / 8 . x / drupal / drupal - 8
. 26 . zh - hans . po
4. Specify the owner and group of the sites directory.
#

chown

- R

apache : apache

/ var / www / html / sites

5. Restart the Apache service.
# / etc / init . d / httpd

restart

6. Open your browser, and in the address bar, enter the URL "Public IP address of the
ECS instance/index.php" to go to the Drupal installation page. Select the required

language from the Choose Language drop-down list, and click Save and continue.

7. Select Standard, and click Save and continue.

8. Enter database information, and click Save and continue.
Note:

After you log on to the MySQL database, you can run the following commands to
customize the database information:
• DBNAME: database name
• UAERNAME: username

• IP: localhost or 127.0.0.1 for a local host
• YOURPASSWORD: database password

mysql > CREATE
DATABASE
DBNAME ;
mysql > CREATE
USER
UAERNAME ;
mysql > GRANT
ALL
PRIVILEGES
ON
' IDENTIFIED
BY ' YOURPASSWO RD '
mysql > FLUSH
PRIVILEGES ;

*. *
WITH

TO ' UAERNAME '@' IP
GRANT
OPTION ;

9. At the end of automatic installation, go to the website settings page, enter site
information, and then click Save and continue.

What's next

Afterward, you can customize your website pages.
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14 Deploy and use SVN
14.1 Overview

Apache Subversion (SVN) is an open source version control system that manages

timeline-based data changes. This topic describes the terms and operations related to
SVN

SVN.

The data that SVN manages is stored in a repository. This repository records all

changes of ﬁles, so that you can reverse the data to an earlier version or review the
change history of ﬁles. The terms and operations of SVN are listed as follows:
• Repository: stores source code.

• Checkout: checks out source code to a local directory.
• Commit: commits modiﬁed code to the repository.

• Update: synchronizes source code in the repository to a local directory.
To manage code in SVN, you typically need to perform these steps:
1. Checkout: Check out source code to a local directory.

2. Other users modify and commit the source code to the repository.

3. Update: Obtain the updates of the source code from the repository.
4. Modify and debug the source code.

5. Commit: Commit the debugged source code to the repository, so other users can
view your modiﬁcations.

SVN manages source code by line. When you and other users modify the code in a ﬁle
at the same time:

• If the modiﬁed code is in diﬀerent lines, SVN automatically merges the modiﬁcati
ons.

• If the modiﬁed code is in the same line, SVN indicates a ﬁle conﬂict. You must
conﬁrm the modiﬁcation manually to resolve the conﬂict.

Procedure

SVN supports access over HTTP or based on svnserve. You can deploy the access to
SVN in these ways:
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• #unique_39
• #unique_40

After you deploy SVN, you can commit modiﬁcations, obtain updates, and reverse
ﬁles by using SVN. For more information, see #unique_41.

14.2 Deploy access to SVN by using svnserve

This topic describes how to deploy access to Apache Subversion (SVN) by using
svnserve.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.

Context

In this topic, the following software versions are used to manually deploy SVN. The
versions may be diﬀerent in your actual running environment.
• Operating system: public image 64-bit CentOS 7.2
• Subversion: version 1.7.14

• Apache HTTP Server: version 2.4.6

Procedure

To deploy access to SVN by using svnserve, follow these steps:
1. Step 1: Install SVN

2. Step 2: Conﬁgure SVN

3. Step 3: Conﬁgure the security group rules

4. Step 4: Use a Windows client to test the SVN service

Step 1: Install SVN

You can install SVN in any of the following ways:
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• Use an SVN image from Alibaba Cloud Marketplace

1. Click here to purchase an SVN image in Alibaba Cloud Marketplace.
2. Click Choose Your Plan.

3. Enter the account and password to log on to the ECS console.

4. In the Image section, the Selected Image ﬁeld shows the speciﬁed SVN

image. Continue with other settings and activate the ECS instance. For more
information, see #unique_23.

• Install SVN manually

1. Connect to a Linux instance by using a password.
2. Run the following command to install SVN.
yum

install

subversion

3. Run the following command to check the SVN version.
svnserve

-- version

Step 2: Conﬁgure SVN

To conﬁgure SVN, follow these steps:

1. Run the following command to create a root directory for an SVN repository.
mkdir

/ var / svn

2. Run the following commands in sequence to create an SVN repository.
#

cd
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create

/ var / svn / svnrepos

3. Run the following commands in sequence to check ﬁles in the SVN repository.
#
#

cd
ls

svnrepos

The SVN directories are described as follows:
Directory

Description

hooks

Stores hook scripts.

db

locks

Stores all version control data ﬁles.
The client used to track access to the SVN repository.

format

A text ﬁle that contains only one integer, indicating the
version number of the current SVN repository.

conf

The conﬁguration ﬁle of the SVN repository, including the
username and permissions for accessing the repository.

4. Set the username and password of the SVN repository.
a) Run the cd
b) Run the vi

conf / command.

passwd command to open the conﬁguration ﬁle.

c) Press the i key to enter the edit mode.

d) Move the pointer to the [ users ] ﬁeld, and add the username and password.
Note:
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You can add the username and password in the following format: username =
password. For example, suzhan (username) = redhat (password), as shown in

the following ﬁgure. There must be a space on both ends of the equal sign (=).

e) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.

5. Set the read and write permissions for the username.
a) Run the vi

authz command to open the permission control ﬁle.

b) Press the i key to enter the edit mode.

c) Move the pointer to the end of the ﬁle, and add the following code. In the code,

suzhan speciﬁes the username, r speciﬁes the read permission, and w speciﬁes
the write permission.
[/]
suzhan = rw

d) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.
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6. Modify the conﬁgurations of the SVN service.
a) Run the command vi
the SVN service.

svnserve . conf to open the conﬁguration ﬁle of

b) Press the i key to enter the edit mode.

c) Move the pointer to the following lines, and delete the number sign (#) and
space at the beginning of each line:

anon - access = read # Assigns
read
permission s
to
anonymous
users . You
can
also
specify
anon - access
= none
to
disable
access
by
anonymous
users . If
you
set
anon - access
to
none , the
revision
history
of
the
SVN
service
shows
dates .
auth - access = write # Authorizes
the
write
permission
.
password - db = passwd # Specifies
the
password
database
file .
authz - db = authz # Specifies
the
file
that
stores
the
authorizat ion
rules
for
path - based
access
control .
realm = / var / svn / svnrepos # Specifies
the
authorizat
ion
realm
of
the
repository .
Note:
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Each line cannot start with a space and there must be a space on both ends of
the equal sign (=).

d) Press the Esc key to exit the edit mode, and type : wq to save and close the
ﬁle.

7. Run the following command to start the SVN repository.
svnserve

- d

- r

8. Run the command ps
has been started.

/ var / svn /
- ef

| grep

svn to check whether the SVN service

The following response indicates that the SVN service has been started.

Note:

Run the command killall
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Step 3: Conﬁgure the security group rules

The SVN server listens on TCP Port 3690 by default. You must log on to the ECS
console to add TCP Port 3690 to the security group. For more information, see

#unique_10.

Step 4: Use a Windows client to test the SVN service

To test the SVN service by using a Windows client, follow these steps:

1. Download and install a TortoiseSVN client on your local computer.

2. Right-click the local project folder. In this example, the project folder is C :\ KDR
.

3. On the menu that appears, select SVN Checkout.
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4. Apply the following settings, and click OK.

• Set the URL of repository ﬁeld in this format: svn :// Public
address

of

the

ECS

instance / SVN

repository

this example, the SVN repository name is svnrepos .

IP

name . In

• Set the Checkout directory ﬁeld. In this example, the directory is C :\ KDR .

Note:

During the logon for the ﬁrst time, you must provide the username and password
that you have conﬁgured in the passwd ﬁle.

14.3 Deploy access to SVN over HTTP

This topic describes how to deploy access to Apache Subversion (SVN) over HTTP.

Prerequisites

You must have an Alibaba Cloud account before you follow the instructions provided
in the tutorial. To create an Alibaba Cloud account, click Create an Alibaba Cloud
account.
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Context

In this topic, the following software versions are used to manually deploy SVN. The
versions may be diﬀerent in your actual running environment.
• Operating system: public image 64-bit CentOS 7.2
• Subversion: version 1.7.14

• Apache HTTP Server: version 2.4.6

Procedure

To deploy access to SVN over HTTP, follow these steps:
1. Install SVN

2. Install Apache

3. Install mod_dav_svn
4. Conﬁgure SVN

5. Conﬁgure Apache

6. Conﬁgure the security group rules

7. Use a browser to test access to SVN

Step 1: Install SVN

To install SVN, follow these steps:

1. Connect to a Linux instance by using a password.
2. Run the following command to install SVN.
yum

install

subversion

3. Run the following command to check the SVN version.
svnserve

-- version

Step 2: Install Apache

To install Apache, follow these steps:
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1. Run the following command to install the Hypertext Transfer Protocol daemon
(HTTPd).
yum

install

httpd

2. Run the following command to check the HTTPd version.
httpd

- version

Step 3: Install mod_dav_svn

Run the following command to install mod_dav_svn.
yum

install

mod_dav_sv

n

Step 4: Conﬁgure SVN

To conﬁgure SVN, follow these steps:

1. Run the following command to create a root directory for an SVN repository.
mkdir

/ var / svn

2. Run the following command to create an SVN repository.
svnadmin

create

/ var / svn / svnrepo

3. Run the following command to specify apache as the user group of the SVN
repository.
chown

- R

apache : apache

/ var / svn / svnrepo

4. Run the following command to create a conﬁguration ﬁle named passwd .
touch

/ var / svn / passwd

5. Run the following command to create the admin user and set the password. In this
example, set the password to admin123.
htpasswd

/ var / svn / passwd

admin

6. Run the following command to create an access permission ﬁle.
cp

/ var / svn / svnrepo / conf / authz

/ var / svn / authz

Step 5: Conﬁgure Apache

To conﬁgure Apache, follow these steps:
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1. Run the command vim

/ etc / httpd / conf . d / subversion . conf to

open the HTTPd conﬁguration ﬁle.

2. Press the i key to enter the edit mode.

3. Enter the following conﬁguration information:
< Location / svn >
DAV
svn
SVNParentP ath / var / svn
AuthType
Basic
AuthName " Authorizat ion
SVN "
AuthzSVNAc cessFile / var / svn / authz
AuthUserFi le / var / svn / passwd
Require
valid - user
</ Location >
4. Press the Esc key, and type : wq to save and close the ﬁle.

5. Run the following command to start the Apache HTTP Server.
systemctl

start

httpd . service

Step 6: Conﬁgure the security group rules

The SVN server listens on TCP Port 3690 by default. You must log on to the ECS
console to add TCP Port 3690 to the security group. For more information, see
#unique_10.

Step 7: Use a browser to test access to SVN

To test access to SVN in a browser, follow these steps:
1. Open your browser.

2. In the address bar, enter the URL http ://< Public
the

ECS

instance >/ svn /< SVN

repository

IP

address

of

name >, and press the

Enter key. In this example, the SVN repository name is svnrepo .

3. Enter your username and password that you have conﬁgured in the passwd ﬁle.
In this example, the username is admin and the password is admin123.

The following response indicates that you have accessed the SVN repository that
you have created.
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14.4 Use SVN

After you deploy Apache Subversion (SVN), you can check out a project from the SVN
repository to a local directory, commit local modiﬁcations to the repository, obtain
updates from the repository, and reverse deleted ﬁles.

Prerequisites

You have deployed SVN. For more information, see #unique_39 and #unique_40.

Commit modiﬁcations

To commit local modiﬁcations to the repository, follow these steps:

1. Right-click the blank area in a project folder, and select SVN Commit.

2. Enter the revision comments, select the modiﬁcations that you want to commit,

and then click OK. Then, the original project in the repository is overwritten by the
project that you have committed.
Note:

A conﬂict occurs when two users modify the same object of the same version and

commit the modiﬁcations. In this case, one of the commitments will fail due to the
backward version. To avoid this issue, you can back up your local project, check
out the latest project from the repository, overwrite the latest project with your
local project, and then commit the modiﬁed project.

Obtain updates

After the project in the SVN repository is updated, you can right-click a blank area in
the local project folder, and select SVN Update to download and display all updates.
Note:

When you right-click a blank area in the local project folder and select SVN Update,
all ﬁles in the project folder are overwritten. Therefore, we recommend that you
back up the original project folder before the update operation, in case some
required content may be overwritten.

Reverse deleted data

To reverse deleted data, follow these steps:

1. Open a local project folder, right-click the blank area in the folder, and then select
SVN Checkout to check out data.
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2. Delete the data you checked out.

3. Choose between the following methods to reverse the deleted data based on your
commitment conditions.

• If you have not committed the delete operation, right-click the blank area in the
folder, and choose TortoiseSVN > SVN Revert.

• If you have committed the delete operation, the modiﬁcation has been

synchronized to the repository, and the corresponding data has also been

deleted from the repository. Therefore, to reverse the deleted data, follow these
steps:

a. Check the revision history and determine the data that has been deleted.
b. Right-click the deleted data and select Revert to this revision.

4. Open the original project folder, right-click the reversed data, and then select SVN
Commit to synchronize the local reversed data to the repository.
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15 Build an FTP site on an ECS instance
15.1 Build an FTP site on a Linux ECS instance

vsftpd is a light, safe, and easy-to-use FTP server for Linux. It is the most popular FTP
server across all Linux versions. This topic describes how to install vsftpd on a Linux
ECS instance running CentOS 7.2 x64.

To build an FTP site on a Linux ECS instance, follow these steps:
• Step 1. Install vsftpd

• Step 2. Conﬁgure vsftpd

• Step 3. Conﬁgure a security group
• Step 4. Test

Step 1. Install vsftpd

1. #unique_47.

2. Run the following command to install vsftpd.
yum

install

- y

vsftpd

3. Run the following command to open and view etc / vsftpd .
cd
ls

/ etc / vsftpd

Note:

• / etc / vsftpd / vsftpd . conf is the core conﬁguration ﬁle.

• / etc / vsftpd / ftpusers is the blacklist. Users on the blacklist are
prevented from accessing the FTP server.

• / etc / vsftpd / user_list is the whitelist. Only the users on the whitelist
are allowed to access the FTP server.
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4. Run the following command to set vsftpd to automatically start on startup.
systemctl

enable

vsftpd . service

5. Run the following command to start the FTP service.
systemctl

start

vsftpd . service

6. Run the following command to view the FTP service port.
netstat

- antup

|

grep

ftp

Step 2. Conﬁgure vsftpd

After vsftpd is installed, the anonymous FTP function is enabled by default. Using the
anonymous FTP function, users can log on to the FTP server without the user name

and password, but do not have the permission to modify or upload ﬁles.

This section describes the following vsftpd conﬁguration methods and the
corresponding parameter descriptions for your reference.
• Grant the ﬁle upload permission to anonymous users
• Conﬁgure local user logon

• Introduction to vsftpd.conf parameters

Grant the ﬁle upload permission to anonymous users

You can grant more permissions to anonymous users by modifying the options in the
vsftpd . conf conﬁguration ﬁle.

1. Follow these steps to modify / etc / vsftpd / vsftpd . conf :
a. Run vim

/ etc / vsftpd / vsftpd . conf .

b. Press the i key to enter Edit mode.
c. Set write_enab
d. Set anon_uploa

le = YES .

d_enable = YES .

e. Press the Esc key and then type : wq to save and close the ﬁle.

2. Run the following command to change the permissions of the / var / ftp / pub

directory, grant write permissions to the FTP users, and reload the conﬁguration

ﬁle.

chmod
o + w
service

/ var / ftp / pub / systemctl

restart

vsftpd .

Conﬁgure local user logon
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Local user logon refers to a user logging on to the FTP server by using the user name
and password for the Linux operation system.

After vsftpd is installed, only anonymous FTP logon is supported. If you attempt to

log on to the FTP server with the Linux user name, your access to vsftp will be denied
. However, you can adjust the vsftpd conﬁguration to allow logon with a user name
and password. Follow these steps:

1. Run the following command to create the ftptest user.
useradd

ftptest

2. Run the following command to modify the password for the ftptest user.
passwd

ftptest

3. Follow these steps to modify/ etc / vsftpd / vsftpd . conf :
a. Run vim

/ etc / vsftpd / vsftpd . conf .

b. Press the i key to enter edit mode.
c. Set anonymous

d. Set local_enab

enable = NO .
le = YES .

e. Press the Esc key and then type : wq to save and close the ﬁle.

4. Run the following command to reload the conﬁguration ﬁle.
systemctl

restart

vsftpd . service

Introduction to vsftpd.conf parameters
Run cat
ﬁle.

/ etc / vsftpd / vsftpd . conf to view content in the conﬁguration

The following table lists all the parameters related to user logon control.
Parameter

Description

no_anon_password=YES

Anonymous users are not prompted for a
password when logging on.

anonymous_enable=YES

anon_root=(none)
local_enable=YES

local_root=(none)
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The following table lists all the parameters related to user permission control.
Parameter

Description

local_umask=022

Umask for the local user to upload ﬁles.

write_enable=YES

Allows ﬁle upload (global control).

ﬁle_open_mode=0666

anon_upload_enable=NO

anon_mkdir_write_enable=NO
anon_other_write_enable=NO
chown_username=lightwiter

Uses umask for ﬁle upload permission.

Allows anonymous users to upload ﬁles.
Allows anonymous users to create
directories.

Allows anonymous users to modify and
delete ﬁles and directories.
Anonymous Upload File belongs User
Name.

Step 3. Conﬁgure a security group

After building the FTP site, you must add a rule to open the FTP port. For more
information, see add a security group rule.

Step 4. Test

On your local computer, access the FTP site by using ftp :// public
address : FTP

IP

port (the default port 21 is used if you do not enter the port).

For example, ftp :// 0 . 0 . 0 . 0 : 20 . You are prompted for your user name
and password if the conﬁguration was successful. After entering the user name and
password correctly, you can perform the relevant FTP ﬁle operations according to
your permissions.
Note:

If you use this method to access the FTP site from the client, you must adjust the

Internet Explorer settings to open FTP folders. Open Internet Explorer, and then

select Tools > Internet Options > Advanced. Select Enable folder view for FTP sites,
and then clear Use Passive FTP.

What to do next

You can take actions to improve your FTP service security. For more information, see
FTP anonymous logon and weak password vulnerabilities.
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15.2 Build an FTP site on a Windows ECS instance

This topic describes how to build an FTP site on a Windows ECS instance. This
method is applicable to Windows Server 2008 and later versions. In this topic,
Windows Server 2008 R2 is used.

The procedure for building an FTP site on a Windows ECS instance is as follows:
• Step 1. Add IIS and FTP service roles

• Step 2. Create FTP user name and password
• Step 3. Set permissions for shared ﬁles
• Step 4. Add and conﬁgure an FTP site

• Step 5. Conﬁgure a security group and ﬁrewall
• Step 6. Test

Step 1. Add IIS and FTP service roles

You must install IIS and FTP services before building an FTP site.
1. #unique_49.

2. Click Start > All Programs > Administrative Tools > Server Manager.

3. In the left-side navigation pane, click Roles, and then click Add Roles.
4. In the dialog box, click Next.

5. Select Web Server (IIS), and then click Next.

6. Select IIS Management Console and FTP Server, click Next, and then click Install.

Step 2. Create FTP user name and password

If you want to allow anonymous users to access the FTP, skip this step.
1. Click Start > Administrative Tools > Server Manager.

2. Click Conﬁguration > Local Users and Groups > Users, right click the blank space,
and select New User. In the New User dialog box, type the new user information.
For example, ftptest is used in this topic.
Note:

The password must contain a mixture of upper-case letters, lower-case letters, and
numbers. Otherwise, the password is invalid.
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Step 3. Set permissions for shared ﬁles

You must set permissions to read, write, or execute for folders shared to users on the
FTP site.

1. Create a folder for the FTP site, right click the folder, and then select Properties.
2. Click Security, select Users, and then click Edit.

3. Edit Permissions for Users. In this example, we grant all permissions.

Step 4. Add and conﬁgure an FTP site

Follow these steps to install an FTP site:

1. Click Start > All Programs > Administrative Tools > Internet Information Services
(IIS) Manager.

2. In the left-side navigation pane, click the instance ID, right click Sites, and then
click Add FTP Site.

3. In the dialog box, specify the FTP site name and the physical path of the shared
folder, and then click Next.

4. Use the default value for the IP address, and then type the port number of this
instance. The default FTP port number is 21.

5. Select SSL settings.

• Allow SSL: Allows the FTP site to support both non-SSL and SSL connections
with the client.

• Require SSL: Requires SSL encryption for communication between the FTP
server and the client.

• No SSL: If No SSL encryption is required, select No SSL.

6. Select one or more authentication methods.

• Anonymous: Allows any user to access the shared content, by entering the user
name anonymous or ftp.

• Basic: Requires users to enter the valid user name and password before they

can access the shared content. The basic authentication method transmits the

unencrypted password through the network. Therefore, use this authentication
method only when you are sure that the connection between the client and the
FTP server is secure, for example, when SSL is used.
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7. Select one of the following options from the Authorization list, and set
permissions:

• All users: All users (both anonymous and identiﬁed users) can access the
relevant content.

• Anonymous users: Anonymous users can access the relevant content.

• Speciﬁed roles or user groups: Only members of the speciﬁc role group or user

group can access the relevant content. Enter the role group or user group in the
corresponding ﬁeld.

• Speciﬁed users: Only the speciﬁed users can access the relevant content. Enter
the user name in the corresponding ﬁeld.

8. Select read and write permissions for the authorized users, and then click Finish.

Step 5. Conﬁgure a security group and ﬁrewall

After building the FTP site, you must add a rule in the security group to allow

inbound traﬃc on the FTP port. For more information, see add a security group rule.
By default, TCP port 21 is open on the server ﬁrewall by default for the FTP service.

If you have entered another port number, you must add an inbound rule to open this
port on the ﬁrewall.

Step 6. Test

On your local computer, access the FTP site by using ftp :// IP

address : FTP

port (the default port 21 is used if you do not enter the port). For example, you

can enter ftp :// 0 . 0 . 0 . 0 : 20 . You are prompted for your user name

and password if the conﬁguration was successful. After entering the user name and
password correctly, you can perform the relevant FTP ﬁle operations according to
your permissions.
Note:

If you use this method to access the FTP site from the client, you must adjust the

Internet Explorer settings to open FTP folders. Open Internet Explorer, and then

select Tools > Internet Options > Advanced. Select Enable folder view for FTP sites,
and then clear Use Passive FTP.

What to do next

You can take actions to improve your FTP service security.
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For more information, see FTP anonymous logon and weak password vulnerabilities.
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16 Use the Vim editor

Vim is a text editor that is developed as an improved version of the vi editor. It can
display text with extra format details, such as font color and underline. Vim is an

essential tool in Linux. For example, you can use this tool to edit conﬁguration ﬁles of
Web applications. This topic describes the modes and commonly used commands of
Vim.

Vim modes

Mode

Normal mode
[DO NOT

TRANSLATE]
Insert mode
[DO NOT

TRANSLATE]

Function

In this mode, you can
copy, paste, and delete
characters or lines.

In this mode, you can
insert characters.

Mode switch

• The tool enters normal mode when
you run the vim < file
name >
command to open a ﬁle.

• To switch from other modes to this
mode, press the Esc key.
To switch from the normal mode to
this mode, enter any of the following
characters: i ,
O .

Note:

You will see --

I ,

a ,

INSERT

A ,

o ,

-- in the

lower-left corner of the editor after you
Replace mode
[DO NOT

TRANSLATE]

In this mode, you can
replace characters.

switch to this mode.

To switch from the normal mode to this
mode, enter R .
Note:

You will see --

REPLACE

-- in the

lower-left corner of the editor after you
switch to this mode.
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Function

In this mode, you can
select a range of text.

You must select a range
of text before running
commands such as copy
, replace, and delete on
the speciﬁed text.
In this mode, you can
search and replace
strings, display line
numbers, save ﬁle
changes, and exit the
editor.

Mode switch

To switch from the normal mode to this
mode, enter v .
Note:

You will see --

VISUAL

-- in lower-

left corner of the editor after you switch
to this mode.

To switch from the normal mode to this
mode, enter :.

Insert

Commands

• i: inserts a character to the left of the current character
• I: inserts a character at the start of the current line

• a: inserts a character to the right of the current character
• A: inserts a character at the end of the current line
• o: inserts a new line below the current line

• O: inserts a new line above the current line
Examples

Assume that you want to edit an example . conf ﬁle that contains the following
content:
#

To
be
able
to
use
the
functional ity
of
a
module
which
was
built
as
a
DSO
you
# have
to
place
correspond ing ` LoadModule ' lines
at
this
location
so
the
# directives
contained
in
it
are
actually
available
_before_
they
are
used .
# Statically
compiled
modules ( those
listed
by ` httpd l ') do
not
need
# to
be
loaded
here .
#
# Example :
# LoadModule
foo_module
modules / mod_foo . so
#
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conf . modules . d /*. conf

Example 1: Insert Location as the ﬁrst line of the example . conf ﬁle. To do
this, follow these steps:
1. Run the vim

example . conf command to open the ﬁle in normal mode.

2. Enter i to switch to the insert mode.
3. Enter Location .

4. Press the Enter key to switch to a new line.

5. Press the Esc key to exit the insert mode.

6. Enter the : wq command to save the changes to the ﬁle and then exit the editor.
After you make this insertion, the example . conf ﬁle contains the following
content:

Location
# To
be
able
to
use
the
functional ity
of
a
module
which
was
built
as
a
DSO
you
# have
to
place
correspond ing ` LoadModule ' lines
at
this
location
so
the
# directives
contained
in
it
are
actually
available
_before_
they
are
used .
# Statically
compiled
modules ( those
listed
by ` httpd
- l ') do
not
need
# to
be
loaded
here .
#
# Example :
# LoadModule
foo_module
modules / mod_foo . so
#
Include
conf . modules . d /*. conf
Example 2: Insert # at the start of line ten in the example .
follow these steps:
1. Run the vim

conf ﬁle. To do this,

example . conf command to open the ﬁle in normal mode.

2. Enter : 10 to move the cursor to line ten.
3. Enter I to switch to the insert mode.
4. Enter #.

5. Press the Esc key to exit the insert mode.

6. Enter the : wq command to save the changes to the ﬁle and then exit the editor.
After you make this insertion, the example . conf ﬁle contains the following
content:

# To
be
able
to
module
which
was
Issue: 20190919
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# have
to
place
correspond ing ` LoadModule ' lines
at
this
location
so
the
# directives
contained
in
it
are
actually
available
_before_
they
are
used .
# Statically
compiled
modules ( those
listed
by ` httpd
- l ') do
not
need
# to
be
loaded
here .
#
# Example :
# LoadModule
foo_module
modules / mod_foo . so
#
# Include
conf . modules . d /*. conf
Example 3: Insert LoadModule

rewrite_mo

. so in the line below the Include

dule

modules / mod_rewrit

e

conf . modules . d /*. conf line of the

example . conf ﬁle. To do this, follow these steps:

1. Run the vim

example . conf command to open the ﬁle in normal mode.

2. Run the / Include
target line.

conf . modules . d /*. conf command to ﬁnd the

3. Enter o to switch to the insert mode.
4. Enter LoadModule

rewrite_mo

dule

5. Press the Esc key to exit the insert mode.

modules / mod_rewrit

e . so .

6. Enter the : wq command to save the changes to the ﬁle and then exit the editor.
After you make the insertion, the example . conf ﬁle contains the following
content:

# To
be
able
to
use
the
functional ity
module
which
was
built
as
a
DSO
you
# have
to
place
correspond ing ` LoadModule '
this
location
so
the
# directives
contained
in
it
are
actually
_before_
they
are
used .
# Statically
compiled
modules ( those
listed
- l ') do
not
need
# to
be
loaded
here .
#
# Example :
# LoadModule
foo_module
modules / mod_foo . so
#
Include
conf . modules . d /*. conf
LoadModule
rewrite_mo dule
modules / mod_rewrit

of

a

lines

at

available
by

` httpd

e . so

Replace

Commands

R: replaces the highlighted characters, until you press the Esc key to exit the
replace mode.
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Example

Assume that you want to edit an example . conf ﬁle that contains the following
content:
#

AllowOverr ide
controls
what
directives
may
be
placed
in . htaccess
files .
# It
can
be " All ", " None ", or
any
combinatio n
of
the
keywords :
# Options
FileInfo
AuthConfig
Limit
#
AllowOverr ide
None
For example, to replace AllowOverr

ide

None with AllowOverr

in the example . conf ﬁle, follow these steps:
1. Run the vim

ide

All

example . conf command to open the ﬁle in normal mode.

2. Run the / AllowOverr

ide

None command to ﬁnd the target.

3. Move the cursor to the ﬁrst letter of None .
4. Enter R to switch to the replace mode.
5. Enter All and a space.
Note:

The word None has four characters, but the word All has three characters.
To replace all the four characters of None, you must type an extra white space
following the three characters of All.

6. Press the Esc key to exit the replace mode.

7. Enter the : wq command to save the changes to the ﬁle and then exit the editor.

After you make the replacement, the example . conf ﬁle contains the following
content:

# AllowOverr ide
controls
what
directives
may
be
placed
in . htaccess
files .
# It
can
be " All ", " None ", or
any
combinatio n
the
keywords :
# Options
FileInfo
AuthConfig
Limit
#
AllowOverr ide
All

of

Delete

Commands

• x: deletes the highlighted character.
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• nx (n represents a number): deletes the highlighted character and the n-1
characters after it.

• dd: deletes the line in which the cursor is located.

• ndd (n represents a number): deletes the line in which the cursor is located and the
n-1 lines below it.

Examples

Assume that you want to edit an example . conf ﬁle that contains the following
contents:

# Listen : Allows
you
to
bind
Apache
to
specific
addresses
and / or
# ports , instead
of
the
default . See
also
the <
VirtualHos t >
# directive .
#
# Change
this
to
Listen
on
specific
IP
addresses
shown
below
to
# prevent
Apache
from
glomming
onto
all
bound
IP
addresses .
#
# Listen
12 . 34 . 56 . 78 : 80
Listen
80
Example 1: Delete # at the start of the # Listen

IP

as

12 . 34 . 56 . 78 : 80 line of

the example . conf ﬁle. To do this, follow these steps:
1. Run the vim

example . conf command to open the ﬁle in normal mode.

2. Run the /# Listen

12 . 34 . 56 . 78 : 80 command to ﬁnd the target so

that the cursor is on the # character.

3. Enter the x command to delete #.

4. Enter the : wq command to save the changes to the ﬁle and then exit the editor.
After you make the deletion, the example . conf ﬁle contains the following
content:
#

Listen : Allows
you
to
bind
Apache
to
specific
addresses
and / or
# ports , instead
of
the
default . See
also
the <
VirtualHos t >
# directive .
#
# Change
this
to
Listen
on
specific
IP
addresses
shown
below
to
# prevent
Apache
from
glomming
onto
all
bound
IP
addresses .
#
Listen
12 . 34 . 56 . 78 : 80
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80

Example 2: Delete the # Listen

12 . 34 . 56 . 78 : 80 line and the line below

in the example . conf ﬁle. To do this, follow these steps:
1. Run the vim

example . conf command to open the ﬁle in normal mode.

2. Run the /# Listen

12 . 34 . 56 . 78 : 80 command to ﬁnd the target.

3. Enter the 2dd command to delete the following contents.
# Listen
Listen

12 . 34 . 56 . 78 : 80
80

4. Enter the : wq command to save the changes to the ﬁle and then exit the editor.
After you make the deletion, the example . conf ﬁle contains the following
content:
#

Listen : Allows
you
to
bind
Apache
to
specific
addresses
and / or
# ports , instead
of
the
default . See
also
the <
VirtualHos t >
# directive .
#
# Change
this
to
Listen
on
specific
IP
addresses
shown
below
to
# prevent
Apache
from
glomming
onto
all
bound
IP
addresses .
#
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